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1. Disclaimer 

Disclaimer 

TissueFAXSplus is a microscope-based cell analysis system for cells in cryocut, paraffin-sections and/or 
TMAs. It consists of the software modules “TissueFAXS” combined with either “TissueQUEST” & 
“HistoQUEST” or with “StrataQUEST” and is used for acquisition of images in brightfield and/or 
fluorescence and/or confocal and/or multiplexing and/or multispectral mode, for counting the number of 
positive and negative cells and/or for quantification of staining intensities and/or classification of 
histological structures. TissueFAXSplus is used for the standardization of tissue analysis in combination 
with immunohistochemical and immunofluorescence staining. 

TissueFAXSplus does not give any direct diagnosis and there is the possibility that the tissue specimen does 
not provide enough information for a proper analysis and/or diagnosis. The cell analysis system only 
measures cellular parameters. Such measurement parameters must in any case be reviewed and validated 
by a qualified human professional with profound knowledge of the sample under investigation and its 
cellular constituents as well as profound knowledge of the cell analysis system and who has received 
special training in the operation of cell analysis methods. The cell analysis system can under no 
circumstances make a decision on the therapy of patients. 

The results of the analysis are purely statistical values. Users must re-evaluate images and likelihood of 
the statistical data. Pure interpretation of statistical data is not allowed. 

  

Notes:  

-  TissueFAXS FLUO is similar to TissueFAXSplus but is for fluorescence samples only and must not be used 
with brightfield/immunohistochemical samples. TissueFAXS FLUO consists of the software modules 
“TissueFAXS“ as well as “TissueQUEST” and/or “StrataQUEST FLUO”.  
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-  TissueFAXS HISTO is similar to TissueFAXSplus but is for brightfield/immunohistochenical samples only 
and must not be used with fluorescence samples. TissueFAXS HISTO consists of the software modules 
“TissueFAXS“ as well as “HistoQUEST” and/or “StrataQUEST HISTO“.  

- TissueFAXS 200 and TissueFAXS SL are similar to TissueFAXSplus but for batch scanning of up to 200/120 
brightfield/immunohistochenical and/or fluorescence slides. TissueFAXS 200 / TissueFAXS SL consist of the 
software modules “TissueFAXS 200“ / “TissueFAXS SL” as well as “HistoQUEST” and/or “TissueQuest” 
and/or “StrataQUEST“.  

- TissueFAXS SPECTRA is similar to TissueFAXSplus but is for multispectral imaging of fluorescence samples 
only. Scanning of brightfield/immunohistochenical samples on TissueFAXS SPECTRA is possible with the 
colour camera, if any, but MUST NOT / CANNOT be done with the multi-spectral camera. TissueFAXS 
SPECTRA consists of the software modules “TissueFAXS SPECTRA“ as well as “TissueQUEST” and/or 
“HistoQuest” and/or “StrataQUEST”. 

Using the unmixing procedure must be done with care as tissue-derived autofluorescence may interfere 
with the algorithm and cause inconclusive or even faulty output. 

Selecting and correctly assigning proper reference spectra is critical for the accuracy of the unmixing result 
and is the sole responsibility of the user. Selecting wrong reference spectra and/or assigning any 
reference spectra inappropriately will cause inconclusive / faulty output and thus generate false 
measurement results! 

- TissueFAXS CHROMA is similar to TissueFAXSplus but is for multi-channel imaging of fluorescence samples 
through narrow band-pass filters only. Scanning of brightfield/immunohistochenical samples on 
TissueFAXS SPECTRA is possible with the colour camera. TissueFAXS CHROMA consists of the software 
modules “TissueFAXS“ as well as “TissueQUEST” and/or “HistoQuest” and/or “StrataQUEST”.  

- StrataQuest provides a software tool for machine learning for the automatic classification of tissue 
structures, including detection of tumor areas in tissue sections. The results generated by the software 
have to be verified by a qualified human professional in any case (negative as well as positive results). In 
case the software does not detect specific histological structures and/or tumor cells, a human professional 
has to verify this result by other means, as it is possible that certain biological patterns and/or special types 
of (cancer) cells may not be detected by the automatic detection function. Measurement errors may also 
occur due to the fact that the cell-environment in which the software has to operate in is highly variable.  

  

We point out to the fact that the following circumstances/factors might influence and/or impair the result 
of the analysis to the level where the result rendered might be inconclusive or even faulty: 

 Quality of the tissue sample: In this context, especially the age of the tissue sample is relevant. 
Long durations between the harvesting and/or staining of the tissue sample and the analysis as 
well as storage errors can tamper with the outcome of the analysis.  

 Quality of the preparation of the tissue sample for the analysis and the materials used: In this 
context, especially the type and quality of the reagents and the capability/precision of the 
person handling the reagents can be relevant and may lead to inconclusive/faulty results (for 
example: dilution-errors concerning the reagents). 

These factors (as well as the capability of the human professional performing the validation of the test 
results) lie solely within the responsibility of the user of the software. TissueGnostics does not take any 
responsibility for test results that are influenced by one of the above-mentioned factors.  
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Each and any product shall be used only after training performed by TissueGnostics or authorized 
distributors of TissueGnostics. A list of authorized distributors is available at the TissueGnostics website.  

https://tissuegnostics.com/global-network/distributors 

The TissueFAXS system and its software applications are FOR RESEARCH USE ONLY. 

By using only parts of the system, changing system components (hardware or software) or using the 
TissueFAXSplus instrument in any other than the intended way it was designed for, the CE-Declaration 
becomes invalid. 

Notices about symbols and labels on product 

The following symbols appear on the labels of the product: 
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2. Installing StrataQuest 

Installation 

To install StrataQuest, locate Installer StrataQuest.exe file on your computer. 

 

Right click on the file and select Run as Administrator. 

 

At this point, make sure you have enough space for the installation on your computer and select a 
storage folder for the application. 

Read the License terms and conditions and check I agree to the License terms and conditions. 

Now press Install. 

 

Wait for the application to be installed. 
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Press Finish to finalize installation process. 

 

StrataQuest application icon will appear on your desktop. 

Note: If you want to use DNN, SONG, t-SNE, UMAP (features that require TissueGnostics Python 
Environment), you must also install TissueGnostics Python Environment on your computer. 

Using the StrataQuest dongle and license files 

To be able to run StrataQuest, you must have a dongle and license files.  

TissueGnostics team will provide you the dongle that must be inserted in your computer's USB port. 

 

Download the drivers for the dongle here: Downloads, utilities and tools for the CRYPTO-BOX 
(marx.com). 
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Make sure to properly select the driver within the Device Manager. If any error occurs, you will see an 
exclamation mark near the dongle name. 

 

 

3. System Requirements 

System Requirements 

Hardware Requirements 

1. Minimum 

 Intel Core i5 - 3 GHz 

 32 GB 

 USB-Port (for dongle) 

 100 GB available hard disk space 

 Single monitor system with full resolution of 1920x1080 

 NVIDIA GPU 4GB (if you use Nuclei DNN Engine) 

2. Recommended 

 Intel Core i7 or Xeon 

 64 GB 

 Internet connection 

 USB-Port (for dongle) 

 2 Terabytes RAID storage (SSD recommended) 

 Dual monitor system with a resolution of 4k 

 

Software Requirements 

 Windows 10 and 11 (recommended) 

Notes: 

- By default, StrataQuest needs to be run by a user member of the Administrators group. In this case, all 
users will share some settings (e.g. institution data, system data, users). 

- StrataQuest can be also run by a user member of the Users group, in which case every user will have its 
own settings. 
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- Please contact your Support team in order to get the desired configuration for your workstation. 

 Once all the components are successfully installed, the application is ready to be used. 

Note: 

- TissueGnostics provides a set-up application that installs StrataQuest and all its dependencies. For 
more information please contact your support team. 

 

Notice regarding virtual machines: 

- TissueGnostics software is not meant to work on virtual machines. Also, TissueGnostics does not offer 
support for these configurations, as the software directly uses advanced CPU features and therefore any 
third layer between the software and the CPU will affect performance and might affect the results of the 
analysis in an unpredictable way. 

 

4. Login & Start 

To start the application, press the StrataQuest icon on your desktop. 

Loading StrataQuest takes several seconds. During this process of program initialization, a splash screen 
is displayed until the application is loaded and ready to be used. 

 

A login dialog will appear. In order to login to StrataQuest, you must enter a username into the User Name 
field and type password into the Password field. Press Log In. 
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Note: First time you open a StrataQuest version after its installation, you must check I agree to the 
terms and conditions. 

Otherwise, you will be notified by a message. 

 

StrataQuest start-up screen will open, displaying two main actions:  

1. Open Existing Project 

2. Import Virtual Slides 

 

 

5. Import Virtual Slides 

The Import Virtual Slides panel allows importing virtual slides in order to create a new project or add 
slides to an already existing project. 
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 Add virtual slides to the project by using drag-and-drop from a folder or by using Browse 
button. 

 The project name and path are automatically filled, based on the first sample to be imported. 
Edit these details by entering other name in the edit box or use Browse Folder button to change 
location. 

Note: It is recommended to store the project in the folder with the virtual slides. Also, the virtual slides 
should be organized in folders and subfolders. This way, StrataQuest will use relative file paths and, if 
you move the folder to another drive or PC, you make sure that StrataQuest will still be able to find the 
images. StrataQuest does not copy the images, it always uses the original virtual slide to show and 
analyze. 

 After the slides have been brought into the import list, you can decide which ones of them will 
be actually imported - just mark the checkboxes for the items to be imported.  

Note: If a project cannot be read or a virtual slide format is not supported, please contact support team 
for more information and options. 

 For each slide, more details are available: regions, thumbnails, channels, size, magnification, 
pixel size (if available). 

 Use Import Options button to refine your selection: choose to include in the import regions, 
subregions and annotations (if any). 

 
  

Filtering Images 

When browsing to import virtual slides, you can use the filtering option to select what types of files will 
be shown in the browser.  Press the arrow to access the filter list. 

If selecting All files, all existing files will be shown.  

 

 

Import Toolbar 

The following actions are available for the import list: 
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 Stop Import 

 Delete All 

 Select all 

 Clear Selection 

 Expand All 

 Collapse All 

 Search 

 

Slide Contextual Menu 

Each slide has a contextual menu, with the following options: 

 

 Copy Full Path 

 Go to Containing Folder 

 Delete 

 Delete All 

 Resume Reading 

 

Reading status for the virtual slides: 

- Reading 

 

- OK 

 

- Failed (slide cannot be selected) 
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Magnify slide image 

Use Eye button to magnify the slide image. 

 

Use Back button to go back to Start-up screen. 

 

5.1. Specific Imports 

There are a few particular cases of import, accessible from More browsing options. Some types of files 
require more steps for importing, each containing specific settings. 

 
 

1. FL BigTiff 

In the Import BigTIFF file wizard, the first step is Choose Images. Browse for the folder storing the desired 
BigTIFF file and select the format of the images. 

A preview is also available. The preview is the first TIFF page which image that is not greater than 
3000x3000 pixels. 

To filter the files from the selected folder, the user should use their extensions or a file naming pattern. 

From the listed images, check the ones you wish to import. 

On the right side of the dialog, you have a preview of the currently selected image. 
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Images grouping 

StrataQuest needs to know exactly which image file belongs to which sample, to which field of view 
within a certain sample and to which channel within a certain field of view. 

To define the sample, the field of view and the marker, follow the next steps: 

 

  

By default, the first image file in the list is selected as filename sample. This can be changed however. To 
choose the filename to be used as a pattern, right click on any file name in the list and click on Set as 
Filename Sample. 
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Mark a part of the Filename example, then press the respective button below it (Sample, Field of View, 
Channel); the selected parts will appear in three different colors (as seen in the image above). 

 

Note: If you changed your mind and want to reselect the parts for Sample, Field of View and Channel, 
just press the Mark again button. 

During the Images Grouping step, the user can see how many images where recognized based on the 
provided file parts (Sample, Field of View and Channel) and which are the recognized images. 

 

Press Finish to access Import Virtual Slides panel. 
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At this point, provide the input for the project: 

 A name for the project; 

 A storage path (use the Browse button); 

 Create the project folder, if it does not exist; 

 Decide what images will be part of the project.  

Using the images management toolbar, you can: 

 Delete all images 

 Select All/Clear Selection 

 Expand All/Collapse All 

 Search 

Press Import to open the new project. 

 

2. FL Multipage BigTiff 

This is an Import Source available only in FL, for single imports (no batch). It reads sample channels from 
the selected TIFF pages (directories). All selected pages must have the same size in pixels and the user 
has to enter the name of the channels. This is different from standard BigTIFF import (where the 
channel is taken from the file name) or OME-TIFF (where the channel name is read from the OME 
Metadata). 

In the Import BigTIFF Multipage file wizard, the first step is to Choose files. Browse for the folder storing 
the desired files. 

 

Also, you have to select Extracted images size and FOV size. 

Then you have to choose what channels will be included in the import: each channel you want to include 
must be checked. 
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The channels names and colors are customizable by clicking on them.  

Export information and a preview are also available.  

Project Creation 

Press Finish to access Import Virtual Slides panel. 

 

At this point, provide the input for the project: 

 A name for the project; 

 A storage path (use the Browse button); 

 Create the project folder, if it does not exist; 

 Decide what images will be part of the project.  

Using the images management toolbar, you can: 

 Delete all images 

 Select All/Clear Selection 

 Expand All/Collapse All 

 Search 

Press Import to open the new project. 

 

3. FL Images Folder 

To filter the files from the selected folder, the user should use their extensions or a file naming pattern. 

From the listed images, check the ones you wish to import. 

On the right side of the dialog, you have a preview of the currently selected image. 
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 You can choose to use 16bit images, if available. 

Setting Columns 

 

 Auto Columns: StrataQuest automatically tries an optimal display of the images under a square 
matrix. 

 Manual Columns: the user manually sets an input column number for the matrix. The number 
of rows will be automatically computed. 

 Manual Rows: the user manually sets an input row number for the matrix. The number of 
columns will be automatically computed. 

  

Images grouping 

StrataQuest needs to know exactly which image file belongs to which sample, to which field of view 
within a certain sample and to which channel within a certain field of view. 

To define the sample, the field of view and the marker, follow the next steps:  
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By default, the first image file in the list is selected as filename sample. This can be changed however. To 
choose the filename to be used as a pattern, right click on any file name in the list and click on Set as 
Filename Sample. 

 

Mark a part of the Filename example, then press the respective button below it (Sample, Field of View, 
Channel); the selected parts will appear in three different colors (as seen in the image above). 
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During the Images Grouping step, the user can see how many images where recognized based on the 
provided file parts (Sample, Field of View and Channel) and which are the recognized images. 

 

Press Finish to access Import Virtual Slides panel. 

 

At this point, provide the input for the project: 

 A name for the project; 

 A storage path (use the Browse button); 

 Create the project folder, if it does not exist; 

 Decide what images will be part of the project.  

Using the images management toolbar, you can: 

 Delete all images 

 Select All/Clear Selection 

 Expand All/Collapse All 

 Search 

Press Import to open the new project. 
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4. BF Images Folder 

In the Basic Settings section, browse for the desired folder. You also have the option to add images from 
subfolders, if any. 

The user can choose to create a sample for each image. 

  
 

Defining Columns and Rows 

You can choose how to define the number of FOVs per columns and rows 

 Auto Columns: StrataQuest automatically tries an optimal display of the images under a square 
matrix; 

 Manual Columns: the user manually sets an input column number for the matrix. The number 
of rows will be automatically computed; 

 Manual Rows: the user manually sets an input row number for the matrix. The number of 
columns will be automatically computed. 

In the Advanced Settings section, choose the extensions for the images to be included in the project. 
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 Press Finish to access Import Virtual Slides panel.  

 

At this point, provide the input for the project: 

 A name for the project; 

 A storage path (use the Browse button); 

 Create the project folder, if it does not exist; 

 Decide what images will be part of the project.  

Using the images management toolbar, you can: 

 Delete all images; 

 Select All/Clear Selection; 

 Expand All/Collapse All; 

 Search. 

Press Import to open the new project. 

  

5. Virtual Slides Folder 

This option helps importing virtual slides in StrataQuest. 
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At this point, provide the input for the project: 

 A name for the project; 

 A storage path (use the Browse button); 

 Create the project folder, if it does not exist; 

 Decide what images will be part of the project.  

Using the images management toolbar, you can: 

 Delete all images; 

 Select All/Clear Selection; 

 Expand All/Collapse All; 

 Search. 

Press Import to open the new project. 

 

6. TissueFAXS Jobs 

This option helps importing TissueFAXS jobs in StrataQuest.  

Browse for a TissueFAXS job on your computer, then select the items to be imported and press Import 
button. 
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5.2. Multispectral Virtual Slides 

Working with multispectral virtual slides is detailed in Spectral Unmixing chapter from Engines 
Reference manual. 

Also, you can find details on how to navigate in Lambda Stacks by going to Dimensions chapter in the 
current document. 

There's a particular situation regarding the import of spectral unmixing projects. 

From a spectral unmixing project that has been run in TissueFAXS, StrataQuest will import the original 
TissueFAXS channels OR only the unmixed channels. 

In other words, you cannot import both original and unmixed channels at the same time. 

 

 

6. Open Existing Project 

  

The first option when opening StrataQuest is Open Existing Project. 
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 You can either open a project from the list (if you already have previously opened projects in the 
list) or browse on your computer for a project. The last project that has been opened is on the 
top of the project list. Double click on the name of a project to open it. 

 To preview a project's details in the list, click on project's name. For each selected project from 
the list, a preview and a set of details are available on the right side. If more samples are present 
in the project, you can scroll with the mouse wheel to view them. 

 If clicking on a region's name, on the top of the preview image you will see the layer structure. 
Press Back to get back to standard preview, without the layers.   

 

 
 Use the Search feature in order to find a certain project in the list. 

Right click on a project name to open its contextual menu. 

 

For each project the following options are available: 

 Copy Full Path: copies full storage path for selected project; 

 Go to Containing Folder: opens containing folder of the project; 

 Delete: deletes selected project; 

 Delete All: deletes all the project from the list. 

Use Back button to go back to Start-up screen. 

7. Main Window 

StrataQuest Main Window is the core interaction center of the application, as the controls are 
functionally grouped in order to ensure a fast and intuitive workflow. 
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In the image below, you can see how the main functional sections of StrataQuest are organized by 
default. 

 

For fluorescence projects, there are some extra features for the channel management. Dimensions 
section can also appear for BF experiments, if time lapse or Z-Stack are present.  

 

Main Window Components 

 Image Viewer, the most significant section, represents the main visualization center and 
includes all the visualisation related tools and features.  

 Left Dock Area: Project Browser and Layers Editor. These are sections that centralize the items 
that form the projects (samples, ROIs. etc.) and their corresponding analysis setup. 
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 Right Dock Area: Image, Diagrams, Object Inspector, Raw Data, Dimension (for FL projects, 
however, Dimensions section can also appear for BF experiments, if time lapse or Z-Stack are 
present.). 

 Categories Bar: shows defined categories of images. 

 Images Bar: shows defined images. 

 Task Manager: shows the status of the running tasks. 

 

Visual Configuration for Main Window 

Depending on your working needs, you can customize the StrataQuest Main Window: which items are 
shown/hidden and where should they be located.  

Go to StrataQuest Main Menu -> View and select in the list the items you want to make visible in the 
application.  

The unchecked items will stay hidden. 

 

You can float and move interface elements of StrataQuest wherever you need, or you can place them on 
different monitors, if available. 

To float an item: 

 Use right click and choose Float from the menu 

 

 Drag it by the header 
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For large displays you can also dock multiple tabs to the sides. 

 

When having two floating items, you can group them using the yellow cross tool. 

You can choose to overlap items in a floating group or arrange them (right/left), as shown in the image 
below. 
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Note: Interface layouts described above are automatically saved and they stay available for the next 
time you open StrataQuest.   

 

7.1. Task Manager 

Task manager helps visualizing the progress of various processes in StrataQuest: 

- Building cache 

- Item analysis 

- Building correction image 

 

Types of status in Task manager 

Below, you can check how some task manager processes are displayed: 

 Idle (no active task) 
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 Running 

The progress of the current tasks is displayed. If clicking on the orange dots, the detail task manager will 
open. 

   

   

 

 Error 

Task manager will turn red when encountering an error. 

Press Show Errors button for details. 
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Actions in Task Manager 

 Stop: stops current running tasks. 

 Pause: pauses current tasks. 

 Resume: continues paused task. 

 

 Clear: clears all finished tasks. If there are any running tasks in the list, they remain in the list 
and continue to be analysed. 

 

8. Image Viewer 

The Image Viewer is the component used to visualize the entire sample and also the ROIs. To visualize 
any item from the Project Browser in the Image Viewer: 

 Double-click on its name; 

 Click on the Eye icon corresponding to each item; 

 Use View or View in New Tab options from item's More menu. 
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8.1. Dimensions 

Dimensions tab is the place to configure the settings for Z-Stack, time lapse or wavelength. Dimensions 
tab is available only for fluorescence samples with Z-Stack, time lapse or wavelength.  

To visualize the channels of a sample there are more display types: 

 
 Show multiple color channels 

 Show single color channel 

 Show single gray channel 

 Show multiple Pseudo IHC channels 

 Show single Pseudo IHC channel 
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Pseudo IHC View 

Pseudo IHC view mode takes a monochrome image and converts it to a 24bpp color IHC-like image. In 
other words, a user can visualize individual channel fluorescent images as converted in brightfield images. 
The purpose of this conversion is an easier visual evaluation of morphological details. 

The feature works for any FL project (8/16 bit). 

 
 

Channel and histogram Properties 

For each channel it is possible to adjust the color and the intensity. 

 

The View button ( ) helps navigating the channels and configuring the visualization: 

 Press the eye button for each channel you want to visualize on the sample. Once the button is 
pressed for a channel, that channel becomes visible in the region viewer. For single channel 
displays, only one button is available. 

 You can toggle between channels by using the eye button. 
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The histogram (for FL projects) shows a graphical representation of the displayed channels of the signal. 
By scrolling with the mouse, you can zoom in or out the histogram. To visualize the histogram at its original 
fit, double click on it. 

 Double clicking on the histogram will reset the zoom range to the entire range. 

 Auto and Default deal with the 16bit range. They operate on the current visible channels. 

 It is possible to adjust grid visibility and logarithmic scales. 

 Right click and move the mouse to define a zoom rectangle. 

 
 Selected channel shows the 16bit range that can be adjusted with drag and drop. 

 

Zoom to predefined range 

It is possible to zoom to a predefined range by selecting one of the given values from the list. 

 

More options for histogram 
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 Log X 

 

 Log Y 

 

 Major Grid Lines: shows major gridlines on histogram. 

 

 Minor Grid Lines: shows minor gridlines on histogram  

 

 Help: opens User Manual for detailed guidance. 

 Edit Ranges shows the min and max range values that can also be edited. Pressing Auto will 
automatically set the values. Apply will save modified values. 
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Lambda Stack navigation 

StrataQuest offers Lambda Stack navigation feature that allows displaying the TissueFAXS acquired 
wavelengths. On the left side there is a list of wavelengths and on the right the existing channels. 

You can view one wavelength per filter. 

     

For the selected filter there are buttons for navigating the stack and also for “playing” the wavelengths. 

 

Below, you can see an example of wavelengths variations on DAPI channel. 
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Z-Stack display control 

TissueFAXS Z-stacks are visible and available for analysis in StrataQuest. You can choose to scroll through 
the Z-stack and “play” slices from a Z-stack. 
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 Within Operations Editor -> Value, the Original Image represents the Z position where the focus was 
done. 

Time Lapse Control 

TissueFAXS time lapses are visible and available for analysis in StrataQuest as individual time frames. 

You can see time lapses for both BF and FL projects. 

You can scroll through the time points and “play” the images from the recorded time points. 

 

Within Operations Editor -> Value, the Original Image refers to the first time (T 0). 

 

8.2. Image Only View 

Image Only feature allows visualizing only the image within the viewer in a full screen. Slide the button to 
the right to activate this feature.  

 

This is useful when you want to focus on image results, presentations or when using a tablet input device 
for manual drawing. 

 

Slide the button to the left to deactivate this feature. 
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8.3. Zoom Options 
 

 

Zooming operations for Region Viewer 

 Zoom in 

-use the Zoom in button. The zoom in is performed centred; 

-Use the ‘+’ keys on the keyboard; 

-Use the mouse wheel. 

 Zoom out 

-use the Zoom out button. The zoom out is performed centred; 

-Use the ‘-‘keys on the keyboard; 

-Use the mouse wheel. 

 Change zoom level 

The current level of zoom is displayed and it can be changed by typing a new value in the edit box.  

 View best fit 

This option allows the user to display the region so that it fits in the display area.  

-use the Best Fit button; 

-use the ‘B’ key on the keyboard. 

 View original size 

This option allows the user to display the region in its original size, as it was acquired (zoom level 100%).  
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-use the View original size button; 

-use the ‘O’ key on the keyboard. 

 Zoom to a specified area of the image 

Select a rectangular area of the image with the mouse (to draw a rectangle, keep the right-mouse button 
pressed).  

This option will zoom centred so that the specified region fits into the display area. 

 

8.4. Shading Correction 

Shading Correction is a feature that removes image inconsistencies that appear especially on the image 
edges. 

Shading Correction button enables/disables the shading correction on the sample. 

   

   

This option is available for all samples. It can be accessed in two ways:  
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 From the image viewer toolbar – in this case, this option will correct only the selected sample. 

 

Note: When activating Shading Correction, if the sample does not have Shading Correction computed, 
StrataQuest will automatically compute it (the button from viewer will become green when the process 
is done). 

 From Project → More → Shading Correction - this option will correct all samples in the project 
items list for which the option was selected.  

 

 

Shading Correction Settings 

 

 For each sample, you can see the channels and the intensity range per channel. Intensity ranges 
are intensity intervals used to compute the correction image. 

 Click on a range to display a histogram. On the histogram, you can modify range's value. 
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 You can know if an item has a correction image by checking its status: yes or no for the image 
shading correction.  

 You can manage the sample list by using Select button. It helps selecting all samples or clearing 
this selection.  

 Delete Correction Image button allows erasing selected correction image. If for a sample, the 
illumination correction is computed and Delete Correction Image is used, the status of shading 
correction in sample/ROI properties will display the word No and in toolbar viewer the green 
Shading Correction button will become grey. The sample status will change to Results not 
updated (if the samples was analysed).  

 If there are more samples, a dropdown list will appear, allowing to select what to delete: 
correction image, selected correction images, all correction images.  

 

 To view selected correction image, press View Shading Correction Image. 

Notes: 

- If unchecking some samples from the list, they will lose shading correction (if it exists).  
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- For the checked samples, shading correction will be computed using the new settings. 

 

 Use Advanced Parameters button to access advanced parameters:  

- Gauss: this is the radius for the Gaussian filter. 

- Sigma: this is the standard deviation used in generation of Gaussian filter.  

Adjust these parameters until you obtain good results. 

 

Press Ok button to apply shading correction with the new settings. 

 

8.5. Viewing Tools 

The Region Viewer includes a set of tools that enhance and complement the visual interaction with the 
sample. 
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8.5.1. Map 

The map displays the entire sample. The part of the sample within the red frame is shown in the Region 
Viewer window. 

To activate map, check the Map option in the View menu. 

 

The map has a set of parameters: size, opacity, location. Changes to these parameters are automatically 
saved by the application. 

To change the default settings, right click on the map and choose Configure Map… from the displayed 
menu.  

 

 Opacity - allows changing the degree of transparency for the map by using a slider.   

 
 

 Size - allows changing the size of the map. By default, the value of this parameter is “Medium”. 

 
 

 Location - allows changing the corner of the Region Viewer in which the map should be 
displayed (top left, top right, bottom left, bottom right) and the indentation from the closest 
border. By default, the map is displayed in the bottom left corner. 
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If no cache is built for the region, map image is not available.  

 

8.5.2. Ruler 

The Ruler shows the physical dimensions of a current viewing size. 

A physical dimension is expressed in metrical units. The Ruler values are computed using the 
experiment’s pixel size.  
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Notes:  

 Depending on the zoom level, the Ruler will display different divisions. 

 If pressing Ruler button, StrataQuest will remember it next time it runs. 
 

8.5.3. Scale Bar 

The Scale Bar is a graphical element which shows a sample scale graphically. 

 

Show or hide the Scale Bar in View section from the Image Viewer toolbar. 

 

To change the color of the Scale Bar and its location on the viewer, go to View -> Settings: 
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Notes: 

 If the user has pressed the Scale bar button, StrataQuest will remember it the next time it runs. 

 If the user changes the pixel size in the Samples Properties, the values displayed by the scale 
bar will also change. 

 

8.5.4. Color RGB 

The Color RGB button shows the color at the current position of the mouse.  

Activate Color RGB feature from View menu: 

 

For color images the RGB (red, green, blue) is displayed. 
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To change the color of the RGB and its location on the viewer, go to View -> Settings: 

   

On the processed grayscale images of the regions (e.g. Shades, Shades Overlay), the indicator will show 
only the gray level. For gray images (Shades, Measurement etc.) only one value is displayed, because red, 
green and blue indicators are equal. 

 

Note:  

 If the user has pressed the Show Color RGB button, StrataQuest will remember it next time it 
runs. 
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8.5.5. Grid 

Show grid button shows/hides gridlines between FOVs. 

  

Activate Grid feature from View menu: 

 

To change the color of the Grid, go to View -> Settings: 
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8.5.6. Smoothened 

Smoothened button, active by default for the original images, will smoothen the image loaded in the 
viewer for a better general visualization. 

  

For processed images, Smoothened is disabled by default. 

8.5.7. Image Name 

If checked in the View menu, Image Name will display the name of the currently opened image in the 
viewer. 

 

8.5.8. Pixel Inspector 

Pixel Inspector is a tool that allows you to visualize information about a pixel selected within the tissue.  

Pixel inspector can be shown in two ways: 

 Go to Image Viewer toolbar and choose Pixel Inspector from View drop down menu 

 Right click on the image in the Image Viewer and select Pixel Inspector 
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Note: The difference between the two modes is that when activated from the viewer the values shown 
are locked to the current pixel. A lock icon is displayed in the top left and you can uncheck it if you want 
to use free mode which displays the values upon hovering. 

Once Pixel Inspector dialog opens, just hover over the image and the pixel information will be shown.   

 

Once the selection is done, you will be able to see the following data: 

 Image Name 

 Pixel location in Sample 

 Pixel location in FOV 

 FOV location in Sample 

 For each composing image, there will be displayed the pixel value and the final value result (the 
one that is displayed). Image tags will be shown in order to see the image type.  

To close pixel inspector, close the window or uncheck the menu entry. 

8.5.9. Settings 

To access General Settings for the Image Viewer, go to View -> Settings:  
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The following settings are available: 

 Default Colors (separated for Brightfield and Fluorescence) for the following elements: Regions 
of Interest, Annotations, Exclusion Areas, RGB Indicator, Scale Bar, Grid Color; 

 Default Locations for the following elements: RGB Indicator, Scale Bar, Item Name; 

 Exclusion Area Transparency: using a slider, set the desired transparency value for the Exclusion 
Areas; 

 Default Overlay Settings: set the color and the thickness of the selected and non-selected 
events in backward connection. Also, set the color and thickness of the dots mask contour and 
the color membrane contour. Checking Show non-selected events in backward connection 
mode will show the non-selected events on the marker images in backward connection mode; 

 Animate borders of ROIs and Annotations option will animate the borders in order to make 
them visible on any background. Enabling this may decrease the overall performance, as it 
requires relevant computing resources; 

 Highlight double-clicked point from Sample: it highlights on the detail window the point where 
a double-click was performed on the main image viewer in order to open the sample; 

 Show grid lines for Samples imported from Folder: all the FOVs on the image will be 
delimitated by grid lines; 

 Show grid lines for Samples imported from TissueFAXS, Hamamatsu NanoZoomer or Mirax: all 
the FOVs on the image will be delimitated by grid lines; 

 Show name only for selected ROI: the label of the ROI will be shown only when the respective 
ROI will be selected; 

 Show name for Exclusion Area: the label of the Exclusion Area will be shown only when this 
checkbox is marked; 

 Show name only for selected Annotation: on the sample will only be displayed the name for 
selected annotations; 

 Show area bubble for shapes while drawing: shows in a bubble the dimensions of the drawn 
area while you are drawing it; 

 Include user name in annotations contents: by checking this option, the user name will be 
included in the annotation edit box; 
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 Show annotations in browser: by checking this option, annotations will be displayed in the 
Project Items Properties panel; 

 Show perimeter of shapes: by checking this option, the perimeter of the regions of interest will 
be shown in the Project Items Properties panel. 

  

8.6. Flags 

Flags is a tool that allows removing selected FOVs from the analysis. 

 

Types of Flags 

 Flag for Removal - definitively erases the selected FOV from project. 

Note: Depending on the input format, images can be deleted from the hard drive. 

 Flag for Exclusion - excludes the selected FOVs from analysis but does not erase them from the 
hard drive, you can re-add them to the analysis later. 

 

 Clear Flags Selection - clears all set flags from the sample. 

 Invert Flags Selection - inverts the current flags selection. 

Note: After each operation of adding flags, check Save in order to retain the selection. 
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9. Project Items 
 
9.1. Project Browser 

The Project Browser is the core tool for managing items in a project (samples, regions of interest, 
annotations, exclusion areas, sample links, playgrounds, compare sets). Every element belonging to a 
project is shown in a tree-like structure for optimal visualization and handling. 

The parent item in the tree is the sample link, then the samples. For each sample there are belonging 
ROIs, annotations and exclusion areas (if created). 

 

Note: If a parent item does not have any ROIs, annotations or exclusion areas, it will not be shown. in 
the image below, check the difference: Regions section only appears if it is populated by ROIs. 

   

By default, the Project Browser is located in the left dock area of the application. However, it can 
become a floating element if using drag-and-drop on the header. To reinsert the Project Browser in its 
default location, use the same drag-and-drop on the header. 
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1. Project Browser Controls 

Project Browser toolbar has a set of options allowing creating and managing items. 

 

 Add Sample Link: creates a new sample link. See Chapter Sample Links. 

 Import: imports new slides to be added to current project. See Chapter Import Virtual Slides. 

 Add Playground: creates a new playground. See Chapter Add Playground. 

 Add Compare Set: creates a new compare set. See Chapter Compare Sets. 

 Collapse All 

 Expand All 

 Search 

 More 

- Filter Search results 

- Delete All: deletes all items from Project Browser 

2. Project Browser Items Controls 

Each item from the Project Browser has a set of fast controls, that vary depending on item type: 

 Sample 

Has the following options: open in Image Viewer, Analyze, More menu.  
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 Regions 

- Regions parent node has the following options: Analyze, More menu. 

 

- Each child region has the following options: open in Image Viewer, Analyze, More menu.  
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 Annotations 

- Annotations parent node has the following options: More menu. 

 

- Each child annotation has the following controls: More menu.  

 

 Exclusion Area 

- Exclusion Areas parent node has the following options: More menu. 

 

- Each child annotation area has the following controls: More menu. 

 

 Sample Link 

Has the following controls: More menu.  
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 Compare Set 

Has the following controls: open in Image Viewer, More menu.  

 

 

 Playground 

Has the following controls: open in Image Viewer, Analyze, More menu.  
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3. Project Items Properties 

For each project item selected in the project browser from the Samples,  Compare Sets, Annotations, 
Exclusion Areas tabs, StrataQuest will display a list of properties, for example: project item type, name, 
rows count, columns count, FOVs count, area, events count, cache built status and illumination 
correction setting. The properties displayed in this list depend of the selected project item. 

To access these properties, right click on the item or on More button and choose Properties. 

 
 Excluded FOVs Count: the number of FOVs excluded from the analysis when using exclusion 

areas or the flags; 

 Total Scanned Area: the initially scanned area of the tissue; 

 Total Excluded Area: the excluded area from the analysis when using exclusion areas or the 
flags; 

Note:  

- For the Line Annotation, the length will be displayed instead of area. 

 Magnification: can be edited by pressing the dropdown button. 

 

 Pixel Size: can be edited by pressing the Pencil button. 
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If pressing Apply to ..., Manage Pixel Size window will open, so you can modify the pixel size for 
selected items. 

 

 Temporary Path 
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4. Slide, Label and Map 

These tabs show thumbnail images for the slide, slide label or slide map, if these images are available. 

 

9.2. Samples 

The analysis in StrataQuest is performed on immunohistochemically stained tissue samples. A sample is 
a set of color images the user wants to analyze using the methods provided in StrataQuest. 

According to the method of choosing the images, a sample can be divided in two types: 

 Sample with related images (this sample is the StrataQuest equivalent of a region of interest 
from a brightfield TissueFAXS project, Fat Cells project, etc.).  

      The StrataQuest projects obtained by importing regions from a TissueFAXS project can contain 
multiple samples. 

      The StrataQuest projects obtained by importing from a Hamamatsu project or a Mirax project or 
other import sources contains only one sample. 

 Sample with unrelated images (this sample comes from importing images from a folder). In this 
case the StrataQuest project will only have one sample. 

Notes:  

- The user can add more samples after the creation of the project with the first sample, using the Add 
Samples from option. The steps to be followed are the same like those when a project is firstly created, 
except the fact the user will not be allowed to change the project name and project folder. 

- After opening a sample in the main viewer and the cache is build, the sample will be displayed in best 
fit mode. 
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For projects obtained with the Import Folder, a default sample is created that takes the name of the 
imported folder. This sample contains the images from the folder arranged in a matrix. 

For projects obtained with the Import TissueFAXS Project the application creates a sample for every 
brightfield TissueFAXS region of interest selected. The name of such a region will be a combination of the 
slide name and the region of interest name provided by the TissueFAXS project. In this way, duplicate 
names are avoided, since regions with the same name can exist on different slides in TissueFAXS. 

 
  
  
Samples options 
  

 Import: imports samples; 

 Add Playground: adds playground; 

 Expand All; 

 Collapse All; 

 Show Search: search field is displayed; 

 

 Filter Search Results: applies filters to search results; 

 Delete All. 
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9.2.1. Add Playground 

StrataQuest playground is a sample-like project item composed of areas of predefined size from existing 
samples.  

It works like a virtual sample and it brings better management of sample’s heterogeneity. By selecting 
various sample pieces, you can determine optimal settings that will eventually be applied to the desired 
samples. 

StrataQuest analyses each area individually and presents results for all areas in the same place, avoiding 
using multiple ROIs. The software offers sample linking and other tools for a quick parameter tuning. 

Playgrounds can be used almost in all the circumstances where you can use a Sample. 

Create Playgrounds 

 
 To create a new playground, press Add Playground.  

 Playground Editor will open: 

 
 Type a name for your playground. 

 Press Select a Play Area. The application will take you to the sample, where you can hover with 
the mouse over the image and select desired area. 

 
 Press Insert to effectively insert the image into the playground. You will receive a confirmation 

message. 
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Now press Ok to create the playground. Another confirmation message will pop-up. 

  

 Optionally, you can add a description to the playground. 

 The playgrounds listed in the Play Areas can be removed one by one or all at once, by pressing 
Remove or Remove All. 

 The parameters of the play area can be configured by pressing Configure Play Area button. You 
can set play area matrix width/height and area FOV width/height. Check Save as default for 
further use of the current configuration. 

Note: After creating a playground, some parameters cannot be changed anymore.  
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Notes: 

 A playground can be created by selecting play areas from more samples. Just make sure all 
these samples are opened and selected, not necessarily in multiple tabs. 

 A playground is added along the samples. 

 As for the sample, the cache is built for the playground. If you edit the playground by adding or 
removing areas the cache will be rebuilt. 

 In the playground, there are no features related to ROIs. Only annotations are available. 

 If the sample where you picked the play areas had illumination correction, the playground will 
inherit it. 

 You can save analysis settings from a playground for further use within a StrataQuest profile. 

 A playground is added to the sample link if the samples are linked. 

 

Playground contextual menu 

Right click on the name of a playground or on the More menu to access the contextual menu: 

  

- View: view playground in Image Viewer 

- View in New Tab: open playground in a new tab in Image viewer 

- Analyze (changes only): analyze only the changes made to playground 

- Analyze: analyze entire playground 

- Rename: rename playground 

- Edit: opens Playground Editor, where it is possible to modify a playground (name, description, 
remove/select play area, configure) 
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- Properties: displays playground properties 

 

- Expand/Collapse All 

- Delete: deletes current playground 

- Build/Delete Cache: builds/deletes cache for current playground 

- Delete Results: erases results for current playground  

- Remove from Sample Link: removes current playground from a sample link  

- Delete Channel: select channels you want to delete for selected playground. 
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9.2.2. Sample Links 

 If you have similar samples, it is easier to make settings once and then apply these settings to all 
samples.  

To accomplish this operation, you need to link the samples, so they will share the same analysis settings 
and other properties.  

If you modify an analysis parameter or add a new StrataQuest image for a sample from a sample link, 
the changes will be also visible on the other samples in the same sample link. 

To access Sample Linking option, go to Project Browser→ Add Sample Link. 

 

The newly created sample link will be listed in the Project Browser. 
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Each sample link has a More menu including these operations: 

- Rename: type a new name for the sample link. 

- Edit: it is possible to add or remove samples to/from the sample link. Just select the items you want in 
the link and press Apply. To manage the samples list more easily, use the batch selection options: Select 
All, Clear Selection, Invert Selection and Show Search. 

Note: Samples can be added to a sample link by using drag and drop feature in the Experiment Browser. 

 

- Expand All: expand all items from the sample link. 

- Collapse All: expand all items from the sample link.  

- Delete: delete the currently selected sample link. 

- Load App: loads a StrataQuest App to the sample link. For details, see Chapter Project Profiles and 
APPs. 

- Load Project Profile: loads a StrataQuest project profile to the sample link. For details, see 
Chapter Project Profiles and APPs.  

- Channels Mapping: applies Channels Mapping to the sample link. For details, see Chapter Channels 
Mapping. 

 

Note: When creating a new project, each sample will be linked to itself, creating something similar to a 
default link.  
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9.3. Regions of Interest 

A ROI (Region of Interest) is a sample area that is of interest for the user and needs to be separately 
analyzed.  

This is a way to restrict analysis only to a certain area of interest. The advantage of ROIs is that you get 
relevant statistics only for what you are interested in and you don’t spend time to analyze areas that are 
not of interest. 

To define a ROI on the sample, press ROI button, then select a shape. 

Note:  

During the definition of a new ROI, an approximation of its area is displayed to the user. 

 

Types of ROIs 

There are more predefined shapes that can be drawn on the sample: 

 Rectangular: For the creation of rectangular ROIs, the user has to select its shape from the shapes 
manipulation toolbar, then the left mouse button should be kept pressed on the sample, the 
pointer is dragged over the interest area and then the mouse button is released. 

 

 Elliptic: For the elliptic ROIs, after its shape is chosen from the shape manipulation toolbar, the 
user has to press down the left mouse button in the middle of the interest area and drag until the 
circular shape of the ROI will surround the desired region. Then, the mouse button is released. 
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 Custom: In order to create the polygon shape of a custom ROI, the user has to select it from the 

shape toolbar. Each line of the polygon is defined by two left mouse clicks, one at the beginning 
and one at the end. When all legs of the desired polygonal shape have been defined, right click 
the mouse in order to finish the custom ROI (and the ROI will be automatically closed). 

 
 Freedrawn: The shape of the freedrawn ROI has to be chosen from the ROI manipulation toolbar. 

To begin defining the shape, the user has to press down the left mouse button and keep it pressed 
while the entire area is surrounded. The shape is defined by the track of the mouse. Releasing the 
mouse button closes the shape. 

 

 

ROIs View 

 Show ROIs: check this option to display existing ROIs on the sample.  

 Show Name Only for Selected ROI: check this option to display the ROI name label only for 
currently selected ROI (this helps when having multiple ROIs drawn, in order to avoid 
overcrowding the viewer). 

ROIs Status 

You can know the analysis status for a ROI by looking for the symbol associated to ROIs name in the 
Project Browser, as shown below: 

 Not processed 
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 Processed 

 

 Results not updated 

 

Show ROI interior 

This option available in the region contextual menu will highlight on the sample the interior of the selected 
ROI. This feature will be useful when a freedrawn shape is very complex and it is difficult to assess its 
interior area. 

Right click on the desired region and choose from the contextual menu Show Interior [Region name].  

  

Automatically display properties for the selected ROI 

When clicking inside a ROI on the sample, the name of the respective ROI will be highlighted in the project 
tree. 

By choosing More option corresponding to a ROI, then Properties from the contextual menu, the 
properties of the selected ROI will be displayed. 
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 Note:  

The same option is available for TMA spots. Select a spot directly on the sample to see its properties. 

In Project Items, for each ROI it is possible to open it in a new Detail Window or choose to analyze it: 

 

 

9.3.1. Tissue Detection 

Tissue detection is a StrataQuest tool helping you save time and improve the accuracy of defining the area 
to be processed (e.g. the section contour). 

In order to detect the ROIs, press Autodetect ROIs button from the ROI manipulation toolbar.  

To improve the results of Autodetect ROIs option, apply Illumination Correction on the sample before 
performing the detection. 

Note: 

To initiate tissue detection, the cache must be already built for that sample. 

The following dialog will appear: 
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By default, the detection is run on the entire preview image. If you want to refine the results, you can run 
the detection on a smaller area: 

 Select the desired area by drawing it on the displayed image; 

 Click Run Selection.  

 If you want to cancel selection, press the Clear Selection button. 

 Once pressed, each existing shape can be modified using the mouse and the blue edit points or the 
edges of the shape. 

User Defined Regions: rectangular/elliptic/freedrawn regions drawn by the user that will be included in 
the detection 

  Rectangular Region 

 Elliptic Region 

  Freedrawn Region 

Add Standard Region: add standard regions by setting a name, a shape and a size. 
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  Add Extension Areas: rectangular/elliptic/freedrawn areas drawn by the user in addition to the 
detection algorithms results (for example - StrataQuest has automatically detected a region and you 
want to manually expand it) 

  Extension rectangular 

  Extension elliptical 

  Extension freedrawn 

Add Excluded Areas: rectangular/elliptic/freedrawn areas drawn by the user that will NOT be 
included in the automatic detection of regions. 

  Rectangular Excluded 

  Elliptic Excluded 

  Freedrawn Excluded 

 Clear: clear all or clear only user regions, extension areas or excluded areas 

 Show All: displays all existing areas 

Zoom out 

 Zoom in 

 Original Size 

 Best Fit 
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 Illumination Correction: enables/disables illumination correction  

  Slide Overlay: displays the Overlay feature. 

 

 Switch between RGB and Gray image: switches between RGB and Gray visualization mode. As 
tissue detection runs internally on a gray image, in order to facilitate the proper selection of the threshold, 
seen the gray image can help. The viewer also shows the RGB or gray value under the mouse cursor. 

   
  
 

Detection Parameters 

 In order to refine the results of the automatic detection, StrataQuest provides a set of parameters you 
can adjust according to your needs, in order to obtain the desired results. 
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 Automatic: if this is checked, the RGB (red/green/blue) channels values are automatically 
determined within three intervals given by the user. These intervals are established by 
increasing the lower (default value is 5) and upper (default value is 255) values. 

 If Automatic option is unchecked, the tissue detection algorithm will use three values given by 
the user for Red, Green and Blue channels. 

 Intensity Threshold: sets threshold for intensity; 

 Tissue Fragments – max. merging distance: try to increase this parameter if your region is split 
into multiple small subregions. The result will be a single region containing smaller subregions; 

 Tissue Fragments – min. area: the smallest area a tissue region can have. All the regions with a 
smaller area will not be considered; 

 Contour Inflate Size: the initially detected region will be inflated with the specified number of 
pixels, in order to entirely include the edges of the tissue and a small surrounding area; 

 Maximum number of regions: sets a maximum number of regions to be detected; 

 Exclude border connected regions: regions touching the border are excluded from detection. 

Profiles 

 
 Default: it allows you to store current set of parameters values for future detection. 

 Restore Defaults: it restores all the parameters to the last saved default parameters. 

 Profile: saves the current parameters settings for further use. 

 Load Profile: loads a previously saved profile from the existing list, by double clicking on it. 

  
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9.3.2. TMA Detection 

StrataQuest offers you special support if you are working with Tissue Microarrays (TMA).    

1. TMA detection 

StrataQuest provides automated tissue detection for TMA structures. By using this feature, the efforts of 
working with TMAs will be considerably reduced. 

It consists in an algorithm based on contrast and uniform illumination. Therefore, applying the 
illumination correction before detection of the TMA spots might be needed. You can do this by using 
Illumination Correction button from Slide Preview toolbar. 

After applying the illumination correction, TissueFAXS can automatically detect the TMA structures on a 
slide.   

Start by pressing the TMA Detection button from toolbar.  

When the automatic detection of TMA structures is initiated, the dialog below will appear. In this dialog, 
the user can restart the TMA detection using different parameters. This operation can be done for the 
whole slide or over a specific selected area.  For best results, the area selected for detection should 
contain mostly tissue. The coverslip borders and other artefact structures should be avoided.    

 

By default, the detection is run on the entire preview image. If you want to refine the results, you can run 
the detection on a smaller area: 

 Select the desired area by drawing it on the displayed image; 

 Click on Run Selection.  
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 If you want to cancel selection, press the Clear Selection button. 

 Once pressed, each existing shape can be modified using the mouse and the blue edit points or the 
edges of the shape. 

Zoom out 

 Zoom in 

 Original Size 

 Best Fit 

 Illumination Correction: enables/disables illumination correction. If there is no illumination 
correction computed for the sample the button will be disabled. 

  

Parameters 

In order to refine the results of the automatic detection of TMA structures, StrataQuest provides a set of 
parameters that can be adjusted according to your needs, in order to obtain the desired results. 

1. Basic Parameters 
 Spot Mean Radius: Represents the radius of the TMA spots. When set to 0, it will be auto-

detected. In case of many broken / incomplete TMA spots or poor contrast (mostly in FL samples), 
it is indicated to be manually set. 

 Blur Size: Blurring filter size (higher the value, higher the blur level). It is indicated when noise is 
present in the image and also for eliminating small details from TMA spots (blurred-but-not-to-
much TMA spots will have a better detection) 

 Background threshold: Used to discriminate TMA spots from background. When set to 0, the 
threshold value will be auto-detected. It is recommended to be manually set when the contrast 
is poor or more than 2 population are visible (ex: background, TMA spots and other marker areas 
inside the TMA spots - automated threshold might detect the value between TMA spots and 
marker area inside TMA spots). 

2. Advanced Parameters 
 Background size: Use this to eliminate the high background and non-uniform illumination. Its 

value should be at least equal to the biggest spot radius. A value smaller than the object of interest 
radius will tend to partially destroy the object. 

 Cells vs small objects ratio: Represent the ratio between the average area of the detected objects 
and the smallest allowed area. Use this to eliminate artifacts/dirt/garbage from the image. 
Objects with an area <Spots vs small objects ratio> times smaller than the average area of all 
detected objects, will be deleted. 
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 Coefficient grid lines minimum distance: Used to generate block's grid. <Coefficient grid lines 
minimum distance> * <Spot Mean Radius> is the minimum distance allowed between 2 
consecutive lines / columns. 

 Area Garbage: Area threshold for all detected objects. Any object with a smaller area than this 
value will be eliminated. 

 Background Threshold Grid Cells: similar threshold as <Background threshold> but this time is 
used for each grid cell to identify each TMA spot. 

 Manual Spot Size: Enter desired value for the spot size in pixels. The value will be used when using 
“New Spot” feature. 

When TMA structures are adequately detected, press the OK button. 

Remove Existing ROIs: press this to remove existing ROIs. It is recommended to keep this option enabled, 
otherwise  

Create Samples for each Spot: press this to create a sample for each detected spot. 

9.3.3. Standard ROIs 

Adding standard ROIs means you are going to add identical ROIs on a sample. 

First, you should choose the type of shape: rectangular or elliptic. 

 

Now press New button to set the height and the width of the desired ROI, then press Add in order to 
include the new standard ROI in the list. 

 Add to Sample: will include the ROI to the sample. After pressing Add to Sample, a rectangle (or 
elliptic shape) will appear on the viewer. Now click on the viewer in the area where you want to 
add the region. The process is continuous, you can automatically add a shape after another. To 
exit from drawing, press Esc key.  If the size of the ROI overpasses the sample, a note will appear 
above Add to Sample button.  
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 Edit: will modify the properties of a ROI from the list. 

 Delete: deletes a selected ROI from the list. 

 Delete All: deletes all ROIs from the list. 

 

Check Use default naming to allow StrataQuest automatically give names to ROIs, instead of manually 
entering the names. 

Notes 

 For the elliptic ROIs, the values from the Width and Height fields refer to the diameters of the 
ellipse (radius value x 2). 

 The last used standard ROI is always remembered. It is selected automatically when opening the 
Add Standard ROI dialog. 

In order to start adding the standard ROI on the sample, press Add to Sample button. Once clicked, the 
user has the rectangle of the ROI following the mouse, so that he can center the ROI on the desired 
area. 

The name of the standard ROI will include its size. 

Note: To exit drawing mode, press Esc from your keyboard. 
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9.3.4. Easy ROIs... 

Using Easy shapes helps adding more regions without pressing Add button every time. Select what you 
want to draw (type and shape) and start drawing in the viewer. After drawing a shape, you can start 
drawing another one without pressing other button. 

Check Easy Shapes to access Easy Shapes Tool.  

   

   

In this dialog you will select: 

 The type of region to be added: ROI, Annotation, Exclusion; 

 The desired shape: rectangular, elliptic, freedrawn, custom, line or polyline (only for 
annotations); 

 You can set the prefix of the shape that will be defined (like a defining mark, for example Tumor 
01): choose one of the existing prefixes or type a new one. If no prefix is set, created shapes will 
have default names (ROI 01, ROI 02). Any prefix can be renamed or removed using 
corresponding buttons. 

   

9.4. Annotations 

An annotation is a shape you can draw on a sample, which can contain clinically relevant information for 
documentation purposes or, for example, second opinion experts’ consultations. 

To define an annotation, press Annotation button, then select a shape and start drawing on the sample. 
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Notes:  

 The line annotation does not show the area, but the distance between two points on the 
sample. You can also see the line size in pixels in Project Item properties when the annotation is 
selected. 

 The area or length of an annotation depends on the FOV size. 

Edit Annotations 

 

 In the Visibility column, mark the checkboxes corresponding to the annotations you want to 
visible on the sample; 

 Locate - see the location of the selected annotation on the map of the sample; 

 Best Fit - gives an optimal display of the annotation in the viewer; 

 Remove - delete the selected annotation(s); 

 Remove all - remove all the annotations from the sample; 

 Insert comment regarding the annotation in the lower-left corner of the Edit Annotations dialog 
and press Save to keep it. 

Note: You can also delete all annotations from a sample by right-clicking on sample’s name in the 
Project Browser and choosing from the contextual menu Remove All Annotations option. 

Annotation contextual menu 

By right clicking on the name of an annotation listed in the Edit Annotation dialog box, a contextual 
menu will appear: 
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 Choose Rename Annotation option to rename the annotation: write the new name in the given 
field, then press Ok to save it. 

 Delete Annotation. 

 Locate: selected annotation will be located on the sample and displayed at the current size of 
the sample. 

 Best Fit: selected annotation will be located on the sample and displayed at the current size of 
the region viewer. 

Notes: 

 To display the user name for the annotations, go to StrataQuest Main Menu → Settings → 
More → Image Viewer, then check Include user name in annotations contents. 

 The specific color of annotations can be set and changed in StrataQuest Main 
Menu → Settings → More → Image Viewer. The annotation color varies for BF and FL. 

 

Edit annotation directly on the sample 

An annotation can also be edited directly in the image viewer: it can be renamed, its content can be 
changed or it can be removed. To edit an annotation, use the little black framed square on the contour of 
the annotation. If pressed, this little square will display an edit box, where you can operate the following 
actions: 
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 Edit the name of the annotation: write the new name in the upper-left corner of the box, then 
press Enter key to save the changes; 

 Write a comment in the space below the name, you can also erase the existing comments (all 
the changes concerning the notes are automatically saved); 

 Delete the annotation by pressing button; 

 Close the edit box by pressing button. 

Annotation Menu 

Right clicking on an annotation will display the following menu: 

 
 Edit Annotation: opens the Edit Annotation dialog. 

 Delete Annotation: deletes the selected annotation. 

 FOV Info: displays the location of the FOV, the channels present in that FOV and the file path. 
Also, if pressing View, you will see the FOV's image for the selected channel. 

 

Project Browser Annotations Menu 

 

Press More button from the Annotations section in the Project Browser to access more options related 
to the annotations management: 

 Expand All 
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 Collapse All 

 Copy All 

 Paste 

 Delete All 
 

Annotations View 

 Show Annotations: check this option to display existing annotations on the sample.  

 Show Name Only for Selected Annotation: check this option to display the annotation name label 
only for currently selected annotation (this helps when having multiple annotations drawn, in 
order to avoid overcrowding the viewer). 

 

9.5. Exclusion Areas 

An exclusion area is a shape you can draw on a sample, which will not be included in the analysis. 

From the total area of the scanned tissue, the exclusion area will be subtracted; no events detected in 
these areas will be taken into consideration. 

 

To define an exclusion area, press Exclusion Area button, then select a shape and start drawing on the 
sample. 
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The Exclusion Areas have some adjustable settings that can be accessed from StrataQuest Main 
Menu → Settings → More → Image Viewer: 

 

 Exclusion Area color: choose the desired color from the color picker. 

 Exclusion Area transparency: move the slider to modify exclusion area transparency. 

 Show name for Exclusion Area: mark this checkbox to display the name of the exclusion area on 
the sample. 

Exclusion Area Contextual Menu 

By right clicking on the Exclusion Area, a contextual menu will appear: 

 

 View Event Data: see data associated to any event from an analysed sample. Event Data panel 
includes the following information: 

  
o The graphical representation of the event, it depends on the currently displayed image; 
o The event label – each event has its unique identification number; 
o Copy all Event Data option - will copy all event data on the clipboard. 

 FOV Info: displays the location of the FOV, the channels present in that FOV and the file path. 
Also, if pressing View, you will see FOV's image for selected channel. 
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 Delete Exclusion Area 

 Copy to Clipboard: creates a copy of the displayed image or of the displayed image with data, so 
you can paste it into another software application (e.g. MS PowerPoint).  

 Save: saves the displayed image or the displayed image with its data under a graphical format 
you can choose (.bmp, .jpg, .gif, .tif, .tiff, .png). 

Project Browser Annotations Menu 

 

Press More button from the Exclusion areas section in the Project Browser to access more options 
related to the exclusion areas management: 

 Expand All 

 Collapse All 

 Copy All 

 Paste 

 Delete All 

 

Exclusion Areas View 

 Show Exclusion Areas: check this option to display existing Exclusion Areas on the sample.  

 Show Name Only for Selected Exclusion Area: check this option to display the exclusion area 
name label only for currently selected exclusion area (this helps when having multiple exclusion 
areas drawn, in order to avoid overcrowding the viewer). 

 

9.6. Compare Sets 

Compare sets is a tool that compares data from different diagrams. 

It is possible to create a compare set for simple samples or for linked samples. 
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Create compare sets 

To add a compare set, got to Project Browser and, from the "+" dropdown menu, choose Add Compare 
Set. 

The newly created compare set will appear in the Project Browser. 

 

A compare set has three sections: 

1. Input: here you can choose the regions to be included in the compare set.  In the Input menu there 
are more options: Edit, Expand/Collapse/Delete All. 

 

If choosing Edit, you will be able to select the regions to be included in the compare set. From the 
existing menu, you can select all regions, clear/invert selection or access Search. 

 

2. Side-by-side diagrams: here you can add side-by-side diagrams. You can add diagrams, edit existing 
diagrams, expand/collapse/delete all. 

Side-by-side diagrams support T-sne, UMAP, Phenotype, scattergrams, histograms. 
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Press Add, then select the input data to create a new diagram, then add another one or close this 
window. 

 

3. Overlay diagrams: here you can add overlay diagrams. You can add diagrams, edit existing diagrams, 
expand/collapse/delete all. 

Overlay diagrams support Phenotype, scattergrams, histograms. 

 

Press Add, select the input data to create a new diagram, then add another one or close this window. 

The overlay shows the analysis of all selected regions within the same diagram, in different colors. You 
can choose which regions will be shown on the overlay diagram, just check the ones you need in the 
legend field. 
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Viewing compare sets 

To visualize a compare set in the viewer, press the eye button. 

 

 

It is possible to resize the diagrams in the compare set by dragging the separation space between the 
columns, as shown in the below image: 
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To reset the histogram layout for an optimal view (after you made changes), go to toolbar, then choose 
More -> Refresh Diagrams Layout. 

 

To add new diagrams, go to toolbar, then choose "+". 

 

Side-by-side diagrams are displayed in a compact layout, so you can visualize more of them. 

The axes of all diagrams are synchronized in zoom in/out, and also when dragging the events of one 
diagram. 

 



 

94 

To edit a side-by-side diagram, just double click on it. Edit Diagram panel will open, there you can make 
any changes, including adding cutoffs and gates. 

You can also activate Heatmap feature. 

     

For Overlay diagrams statistics are shown, based on categories. Each region displays its own statistics. 

The diagram range for all regions is synchronized, if one is moved, all the other will automatically adjust. 

 

If right clicking on an overlay diagram, a menu with more options will appear: 
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You can: 

- reset diagram name 

- export diagram image 

- select export options 

- copy/paste 

- delete 

 

Diagrams Settings 

To access diagrams settings, go to compare set toolbar, then choose More -> Settings (also see 
chapter StrataQuest Generic Settings). 

   
    

Common settings: 

- show grid 

- select cutoff color 

- set small range limit 

- set cutoff decimals 

- set cutoff percentile value 

- choose compare set layout: show regions on columns or show diagrams on columns 
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Scattergram settings: 

 

- choose point style for scattergram events 

- choose point size for scattergram events 
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- choose point style for 3D diagrams 

- choose point size for 3D diagrams 

 

Histogram settings: 

 

- set bins count value 

- select line style 

- select histogram color 

 

10. Analysis Setup 

Analysis in StrataQuest 

After having created a project and doing analysis setup, StrataQuest is ready to run analysis. 

StrataQuest allows analysing an entire sample, several samples or regions of interest.  

Analysis involves many steps from simple to sophisticated image processing and high-level mathematical 
operations (depending on number and size of samples/ROIs) that may be time consuming. Therefore, 
you can choose whether analysis should be run for entire samples, a smaller representative ROI or just 
relevant parts. This way, the best configuration can be chosen for analysis of samples. 

Note: While the analysis is performed for any region, some of the operations cannot be done and they 
appear disabled in the menus: operations with flags, finalize analysis, layers or engines changes, engines 
parameters changes, remove sample and ROIs. 

During analysis, a taskbar is shown. You can stop, pause or clear tasks (see above Task Manager). 
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1. Sample Analysis 

The analysis for a sample can be done in more ways: 

 Using Analysis option that appears near the sample name (from the Project Items). You can 
analyze everything or just the changes (if any). StrataQuest will remember the choice for the 
next run. 

 
 The Main Window Analyze button will display a panel where you can select the samples to be 

analysed.  

Analyze and Analyse (changes only) will analyse currently selected item. 

 

Analyze Multiple Items will open a panel where you can select items to be analysed. 

 

Select menu opened by pressing the More button will display a set of selection options: 
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 Select All ROIs; 

 Select Processed ROIs; 

 Select Unprocessed ROIs; 

 Select All Samples; 

 Select Unprocessed Samples; 

 Select All Samples and ROIs; 

 Clear Selection. 

You can customize the analysis process using the following options: 

 Analyse Changes Only: only analyses the changes that were made since the last analysis. 

 Build cache for Sample if Missing: will build the cache if it has not been previously computed. 

 Shut Down After Finish:  the computer will automatically shut down after the analysis is done.  

Note:  

           - Make sure no other applications are running that will require the computer to stay on power, 
when you select Shut down after finish option!  

           - Analysing the sample will delete all previously obtained data. 

 

2. ROI Analysis 

In order to analyze a ROI, there are more possibilities: 

 Analyze from the right mouse button menu on ROI's name from Project Items. You can analyze 
everything or just the changes (if any).  
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 Analyze button near ROI's name. You can analyze everything or just the changes (if any).  

 

 

 The Main Window Analyze button will display a panel where you can select the regions to be 
analysed.  

Analyze and Analyse (changes only) will analyse currently selected item. 

 

Analyze Multiple Items will open a panel where you can select items to be analysed. 

 

Select menu opened by pressing the More button will display a set of selection options: 
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 Select All ROIs; 

 Select Processed ROIs; 

 Select Unprocessed ROIs; 

 Select All Samples; 

 Select Unprocessed Samples; 

 Select All Samples and ROIs; 

 Clear Selection. 

  

You can customize the analysis process using the following options: 

 Analyse Changes Only: only analyses the changes that were made since the last analysis. 

 Build cache for Sample if Missing: will build the cache if it has not been previously computed. 

 Shut Down After Finish:  the computer will automatically shut down after the analysis is done.  

Note: Make sure no other applications are running that will require the computer to stay on power, 
when you select Shut down after finish option!  

 

10.1. Layers and Engines 

An introduction to StrataQuest layers and engines 

StrataQuest analysis setup is defined by one or more Layers. 

A Layer is a set of engines structured in a predefined way and following some interconnecting rules that 
aim at detecting some type of objects and measuring them. 

An Engine is the basic building block in the image processing pipeline and can be thought like an algorithm 
which takes some inputs and produces some outputs. Engines complexity can vary from simple ones that 
add two images to complex ones like classification. 
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Engine’s input are images – built-in images (like the “Original” image in BF or channel images in FL) or 
images produced by other engines in the same layer. 

The types of images supported by StrataQuest are the following: 

 Gray – 8bit or 16bit. 

 Color – 24bpp. 

 Float. 

Below you can see an example of how engines chain together. 

 

Every engine can have parameters – these refer to images (this is not mandatory, there are engines that 
have implicit image inputs) and other numeric parameters or options that allow you to tune the results. 

10.1.1. Layers 

Structure of a layer 

The layer structure that defines what engines can be added and how they can be linked is pictured 
below: 

 

Each category in the layer’s structure allows a specific set of engines. An engine from a category can use 
inputs from the previous categories or from the same category as long as circular dependencies are not 
made (otherwise StrataQuest will be in a loop when running the analysis). 

Not every category needs to have engines added – this depends on what you want to do. 
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The complete list of engines with their description can be found in the “Engines Reference” document 
that can be accessed from StrataQuest help menu. 

As with the engines, layers can also be linked. Given that an engine can only work with images defined in 
the same layer (or the original raw input color or channel images), how can you link engines? The answer 
is the “Import” engines where you can select a layer and the image that you want to import. Like for 
engines, circular dependencies between layers are not allowed. 

 

Running analysis workflow 

When running analysis for a Sample or ROI, layers are processed in the order of dependencies. First the 
layers that do not depend on other layers are processed and then the processing follows the 
dependencies. 

The analysis inside a layer follows the layer’s categories going from “1. Pre-Processing” to “6. 
Measurements”. 

Engines inside a category are also run based on dependencies – first the engines that do not depend on 
other engines and then the processing follows the dependencies. 

Running an engine usually requires analysing each field of view from the Sample or ROI. This is typically 
done in parallel and the order in which the FOVs are processed is undefined, depending on the number 
of FOVs and the number of threads set for processing (see Task Manager options). Storing image results 
is also done for each FOV – so if you have 10 FOVs inside a sample and 2 image outputs for an engine 
there will be saved 2 sets of 10 images corresponding to each output and FOV. 

Note: There are engines that do not run FOV by FOV but from an image from the cache. Still, the output 
images are then projected back to FOVs so other engines can use them. 

Notes:  

- Usually the engines run on the original image, but if you don’t need the entire image resolution the 
engines can be run on a downscaled image. Still, the output images are then resized to the original 
resolution so other engines can use them. The resize settings is an option for the layer and applies to all 
engines in the same layer (except Measurements – these are always done on the original resolution). 

- There are engines that do not run FOV by FOV but from an image from the cache. Still, the output images 
are then projected back to FOVs so other engines can use them. 

 

Storing objects and stitching 

The purpose of the layer is to detect or “segment” objects. There are various ways to segment images, 
like thresholding, but whatever the method results are stored in labelled (or coded in StrataQuest) images. 
In StrataQuest the coded image is a color image (24bpp) that can store maximum 65535 labels.  

Note: There are also 32s images as well – the cache images of global/stitched labels. 

In the example below, you can see 4 FOVs with some objects (in orange) and their labelling (in black). 
The labelling is done FOV by FOV (the so-called local labels). 
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But if StrataQuest stores local labels, then how can it handle objects that spread across FOVs? The answer 
is “stitching” which is an additional processing step after “2. Detection”, which is run for every layer that 
is set to stitch objects (the default).  In this step the local labels on FOV’s borders are matched giving global 
labels. In the above images with black are numbered the local labels and with green the global labels. For 
example, the global event “2” is composed of the local event “2” from “FOV 1” and local event “1” from 
“FOV 1”. 

The stitching information is not stored in the coded images but in the StrataQuest project file and the 
engines have access to it and can handle global labels. 

Notes: 

- There are cases in which you don’t want the stitching algorithm to be run (for example in case of Import 
Folder where the images are unrelated). This can be changed from the layer’s properties. 

- There are some advanced parameters for the stitching algorithm that can be accessed from the layer’s 
properties but the defaults provide good results. 

Layers general operations toolbar 

Layer specific operations are gathered within the layer toolbar, as shown below: 

 

 New Layer: press to add new layer. StrataQuest will automatically create and name the new 
layer, but you can rename it by clicking on its name in the Layers Editor and type the desired 
name. 

 Remove All Layers: press to remove all layers. 

 Quick Search: search item within Layers list. 

 Collapse All: collapse all layers list. 

 Expand All: expand all layers list. 

More options for layers 
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 Load/Save App: loads/saves a specific SQ APP. 

 Load Project Profile: loads previously saved project profile. 

 Save Project Profile: saves current project profile. 

 Go to Easy Mode: Switches to “Easy Mode” view. This functionality is subject to licensing and 
it’s not available for basic licenses. 

 Easy Mode Editor: Opens the “Easy Mode Editor”. This functionality is subject to licensing and 
it’s not available for basic licenses. 

 Show WBS: Shows the “Work Breakdown Structure” column. This is an automatic numbering of 
the levels in the layer’s tree that helps identifying items faster. 

 Advanced 

 

- Filter Search Results: you can filter the search results to see only the rows that correspond to your 
search criteria; 

- Variables: these are some global variables useful for measurements engines (for example Total Area 
Measurement). As the variables by pressing New button, then set desired value and press Apply. 

- Export Graph: it exports engines’ configuration in GraphML format files. 

 Delete All Layers 

 

Individual Layer Actions 
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Quick help editor: allows adding an explanation regarding current layer. If there is a Quick Help added a 
question mark icon will appear in the Layer’s actions area. 

Delete: deletes current layer. 

Quick Actions: these are actions used to combine frequent operations in a single action 

There are multiple Quick Actions types based on the context from which they are triggered: 

 Layer 

 Engine 

 Engine Output 

 Diagram  

The first three types of actions can be found in the “More Options” button from the “Layers Editor”. 

The last type can be found in the contextual menu of a diagram or a gate from or from the contextual 
menu of the statistics table shown in “Diagram Detail” window. 

Some actions appear only if there is a context to operate on – for example for Color Separation you need 
to have some markers defined, for Classifier you need to have some classes defined, etc. 

Some actions also require some user input – a submenu for a quick selection or an additional dialog. 

 

Summary of the initial Quick Actions 

Layer: 

 “Add IHC 2/3” – available on BF, adds a Color Separation with 2/3 markers, a Nuclei detection 
with first marker, a Cellular mask for the others and measurements for all the markers. 

 “Add Total Area 2/3 markers” – available on BF, adds a Color Separation with 2/3 markers, an 
Area with the first marker and a Standard measurement for it and for the other markers, creates 
a new layer in which imports the corresponding shade and does the same for measuring the 
marker area. 

 “Add Single cell analysis on” – available on FL, it asks the user to select the nuclei channel from a 
submenu, adds a Nuclei detection on it with Standard measurements. 
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 “Add Single cell analysis (with cell masks) on” – available on FL, it asks the user to select the 
nuclei channel from a submenu, adds a Nuclei detection on it with Standard measurements and 
for all the other channels it adds a Cell mask and a corresponding Standard measurement. 

 “Add total area of” - available on FL, it asks the user to select a channel from a submenu, adds 
an Area detection and corresponding Standard measurement. 

Engine: 

 Color Separation – Add Nuclei Segmentation and measurements – for the first marker will add 
Nuclei detection on it and corresponding Standard Measurements. 

 Color Separation – Add Nuclei & Cell Segmentation and measurements – for the first marker will 
add Nuclei detection; for other markers - a Cellular mask; and for all a Standard Measurement. 

 Total area – “Filter input” – appears only if an input is set; shows a submenu with the type of 
filter; adds a BOM engine with the filtering operation, sets its output based on image type and 
sets it as input for Total Area. 

 Total area – “Use Otsu Threshold (Global)” - appears only if an input is set; adds an “Otsu 
Threshold (Global)” on the original input; checks “Use Global Variable” and sets it to the output 
of the “Otsu Threshold (Global)”. 

 Classifier – “Add class quantification layers” – appears only if there are some classes defined; 
shows a submenu for selecting the classes to work on; adds Nuclei detection if detection is not 
set; adds an “Assign objects to classes” engine for the classifier class map; defines a histogram 
with the measurement and defines gates for each corresponding class value; for each class – 
add a layer, import coded with the gate corresponding to the class and set detection to Existing 
coded. 

 Classifier – “Add class area quantification layers” – appears only if there are some classes 
defined; shows a submenu for selecting the classes to work on; for each class – define a layer, 
import the corresponding class mask; add Total Area detection and measure are using Standard 
Measurements. 

Proximity – “Add Proximity areas quantification layers” – appears only if there are some areas defined; 
adds Nuclei detection if detection not set; adds an “Assign objects to classes” engine for the Proximity 
gray map; defines a histogram with the measurement and define gates for each corresponding area 
value; for each area – add a layer, import coded with the gate corresponding to the area and set 
detection to Existing coded. 

Diagram: 

 “Create layer for gate/quadrant” – adds a new layer; import the objects shown in the diagram 
using the selected gate and adds Existing coded as detection. If the diagram, cutoff or gate is not 
propagated, it will be automatically propagated. 

 “Add Statistics Report column” – adds a new Statistic Report column for the selected gate. If the 
diagram, cutoff or gate is not propagated it will be automatically propagated. The action will 
display a dialog so the user can enter the name and the desired Unit. 

Output: 

 “Measure area” – available for gray outputs. It adds a new layer, imports the selected image, 
adds Area detection and standard measurements for Area. 

Layer Properties 

Each layer has some parameters that can be adjusted. 
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Events Strategy 

Analysing a ROI implies restricting the detection results to the shape of the ROI and here comes the 
question how events on border that do not fit entirely in the shape are handled. This is defined by “Events 
Strategy” configuration. 

To access the Events Strategy, go on layer’s name from the Layers Editor -> More -> Properties. 

 

  

 

Stitch objects option 

The events within a ROI can be computed and displayed in three different ways: 
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 Select only events entirely in ROI: only the events placed entirely in the ROI will be considered 
for evaluation; 

 

 Select events entirely or partially in ROI: an event placed on the edge of the ROI will be 
considered for evaluation, even if it overpasses this edge; 

 
 Crop events to ROI’s shape: for an event placed on the border of the ROI, it will consider only 

the part inside the ROI. 

 
 Notes: 

- When Crop events option is used, the events will be computed if the regions belonging to the group 
are not overlapping. If regions are overlapping, events computation is not yet available. 

- Changing this strategy will only show effect on the data level after the algorithm has been run (again). 

- This strategy is recommended for Total Area Measurement, where total area within the selected 
region is required. In a single cell analysis, this strategy cuts the cells on the border and measures the 
cell fragments creating thus measurements which might not be relevant or desired. 
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If a ROI is modified and it also contains results, the user will be asked whether he wants or not to reanalyse 
it again. 

Resize factor: analyses the image to a smaller resolution in order to fasten the analysis process. 

10.1.2. Engines 

For detailed descriptions related to engines, please consult StrataQuest 8.0 Engines Reference 
document. 

Notes:  

 Please note the fact that the engines listed in the Layers Editor may vary depending on the 
license you own. For more information please consult the support staff. 

 Engines have a help link that open the Engine References document to the page corresponding 
to that engine. This helps documenting on an engine faster. 

Engines operations workflow 

 

A layer has a set of options visible near its name: 



 

111 

 

1. Analyze  

 

2. Add Engine/Layer 

 

Each StrataQuest layer is composed of more layer categories: 

 Pre-Processing 

 Detection 

 Post Processing 

 Manual Correction 

 Measurements Masks 

 Measurements 

For each layer category it is possible to add engines by using Add button (1). From the list of engines select 
an engine and it will automatically appear as a child under the current layer category (2). Below the engine 
node there will be a child node for each engine output. 

The parameters regarding selected engine will be visible under the layers section (3). 

It is also possible to create image types for each engine. Press More Options button of the engine’s 
toolbar, then choose Add Images for Each Output (4). 

The images types can now be found in the Images tab (5). 

A category has a set of options visible if clicking on that category: 
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 Lists of available engines for each layer category. 

 Delete all engines for selected category. 

3. More options 

 

 Rename engine: type a new name in the name field 

 Properties for current engine 

 

 Quick Help Editor: adds an explanation regarding current layer. If there is a Quick Help added, a 
question mark icon will appear in the Layer’s actions area. 

 Delete engine 

 Quick Actions: these actions vary from engine to engine 
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11. Analysis Results 
 

11.1. Raw Data 

Raw Data represents a tabular format of the measurements of events inside a layer. 

 Raw Data tab for current sample/region is located in the right dock of the application. 

 
 

 Raw Data can also be accessed from StrataQuest Main Menu -> Project -> Raw Data.  Raw Data 
option accessed from Project menu can be considered a global Raw Data, as it concerns all 
samples and regions. Its purpose is mainly to make batch exports for multiple items. 
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A row corresponds to an event and the columns represent the measurements. There is an additional 
column that helps you identify the event, called Event Label. 

 

In the Layer dropdown, select a layer to show its events. By default, the first layer is selected. 
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Measurements 

Press Measurements button to select the measurements (columns) to be added for selected layer, by 
checking corresponding checkboxes. 

If you don't make any change, all measurements are shown by default. If new measurements are added, 
they will also be checked by default.  

Once you make some changes, the new measurements will not be added anymore. 

 

More button for Measurements will display the following operations related to measurements list: 

 Select All 

 Clear Selection 

 Invert Selection 

 Show Search 

 Show Engines 

 

Raw Data options 

 Sorting and filtering: right click on a column's head to access the sorting and filtering options. 
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 Summary row is a feature that allows viewing the following numerical values for each of the 
columns from the raw data window. You can access this menu by pressing the right mouse 
button on the area below any of the columns. 

 

- Sum: the sum of all values of the column;  

- Min: the lowest value of the column;  

- Max: the higher value of the column;  

- Count: the number of existing values per column;  

- Average: the average value for the entire column. 

Note: For each of the columns you can add one or more summaries. 

 Double clicking on an event will highlight it in viewer. 
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 Backward connection feature is available in raw data for filtered events. Use the filter option 
corresponding to each column or click on the header of a column to enter filter input. 

   

Press BC button to activate backward connection mode. For details see Chapter Forward and Backward 
Connection. 

 

 Status of events loading is available in the lower part of the Raw Data panel. There are two 
status types when loading events: Ready and Loading.   
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Note: Loading images and raw data is an asynchronous process: raw data appears first, but events may 
appear later, especially if their number is very large. 

 Moving columns: you can rearrange the columns in raw data by using drag-and-drop on the 
head of each column. 

 

 Export Raw Data for current region  

You can export raw data for selected layer in various formats: .xlsx, .csv, .pdf, folder. 

 

- Export all columns option will export all existing columns of a layer. Otherwise, only visible columns 
will be exported. 

 Batch export for Raw Data 

You can export Raw Data for more regions/samples by opening Raw Data window from StrataQuest 
Main Menu (Project -> Raw Data...). Then select desired items from the left dock area by checking 
corresponding checkboxes. 

Press Export To and choose export type. 
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Note: 

- XLS export has limitation for the number of rows, as shown in the image below: 

 

 

11.2. Object Inspector 

For each detected event, you can see its corresponding data by hovering with the mouse over the event. 

The data will be displayed in Object Inspector tab, as shown in the image below: 
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11.3. Image Results 

Images Overview 

Images section in StrataQuest allows manually selecting certain images from the projects for further 
visualization. 

In the Images tab, press Add Images (+) in order to access the available images list and make your 
selection. 

    

The images chosen to form an “SQ Image” can be from any layer. 

The defined SQ Images will be the same for all samples in the same Sample Link. 

Structure of an Image 

An Image is defined by Backgrounds and Contours.  

The Background contains the following: 

1. Original Images: has original images for both BF and FL samples - Original Image (BF), Overlay and 
Channel Images (FL).  

2. Another type of images present in this section are images generated by background compatible 
engines. These images inherit layer's name. If layer's name changes, it will also be automatically update 
in the image title. 

For the Background section, the following output types are available: color, gray, gray 16bit or float 
output. These outputs are mentioned as tags added to the images. 
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Display parameters 

Each image type has a set of display parameters, that are visible after selecting the image. These 
parameters vary depending on the image type: 

 

 Intensity (Color, Gray 16, Gray) 

 Color (Gray 16, Gray) 

 Channel range and histogram (Gray 16) 

Each modification done to these parameters will automatically update the image displayed in the Image 
Viewer. 

Background images list can be managed using the available controls: 

 

 Expand: expands list; 

 Collapse: collapses list; 

 Search: enables search function; 

 Selected: shows only images you have selected. 

Contours 

The Contours are coded images that represent different objects or masks. For every coded image there 
are various coloring options. 

The output type for Contours images is Coded, that is shown as a tag attached to the image. 
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Display parameters 

Each image type has a set of display parameters, that are visible after selecting the image.  

 

Parameters for Coded output images: 

 For Normal Contour: Intensity, Color, Fill  

 For Selected Contour: Intensity, Color, Fill   

Note: Selected Contour will not be displayed for coded images that are not generated by detection 
engines. 

Each modification done to these parameters will automatically update the image displayed in the Image 
Viewer. 

Normal Contour Properties 

- Color Change for the Normal Contour: select a color for the Normal Contour; 

- Single Color Display: this is the default selection for the Normal Contour, you can adjust its thickness; 

- Labelled Display: this is a selection you can make in order to see event/label (contours) drawn/painted 
with different colors to help in the visual differentiation between labels/events. Its thickness is 
adjustable.  
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Contours images list can be managed using the available controls: 

 

 Expand: expands list; 

 Collapse: collapses list; 

 Search: enables search function; 

 Selected: shows only images you have selected. 
 

Add Image - More menu 

 

 Rename: the image button becomes editable and you can write a new name; 

 Reset Name to Default (enabled only if the name has been previously changed): resets image 
name to default; 

 Color: changes image button color; 

 



 

124 

Categories: selects a category for the new image. 

Note: By default, any new image goes to Untagged category. 

 

 

11.4. Categories Bar 

StrataQuest images can be organized into what we call categories, for an easier handling.  

There are some default predefined categories, but users can define their own categories and assign 
Images to them. 

The predefined categories are Favorites, Channels (FL only) and Untagged. For FL-MS samples, there will 
be also a category for each filter. The predefined categories cannot be renamed or deleted, they can only 
be hidden. 

Managing images in categories 

An image can be assigned to multiple categories. Adding images into a category can be done by editing 
the image or by dragging an image from the image bar to the desired category.  

Adding images to the Favorites category is done by pressing the Star icon on the left. 

In the image below, the DAPI image is in the Channels category but also in the Favorites category, as it 
was marked as such. 

 

To select a category, press on it. The selected category will have orange text. The images from the 
selected category are shown below, in the images bar. If there are no images, there will be an info 
message.  

The order of the images in a category can be changed by drag and drop.  

If there is no item loaded (Sample or ROI) the category bar will be empty. 
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In the images below, you can see a categories bar for FL experiments and another one for FL 
multispectral experiments. 

 

 

Categories Options Menu 

 

 Add Category: adds a new category. The newly created category has a default generated name 
and it is in rename mode, so you can easily enter a custom name. 

 

Note: The name of a category must not be empty, must be unique and have maximum 50 characters 

 Show Hidden 

The categories can be hidden from the toolbar. No information is lost, only the category button is not 
visible anymore. In order to make the category visible again, go to category More menu and press Show. 
The hidden categories are shown with italic text when shown.  

 
 Delete All: deletes all visible categories. The images are not deleted. The images that are not in 

other categories are moved to Untagged. 

 Help: shows the Help Window with explanations related to the topic. 

 Categories - More menu 

Each category has a More menu, accessible by clicking the More icon or by right clicking the category 
button.  

The displayed options may vary, depending if the category is built-in or user defined.  

- Add images:  
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- Rename: activates Rename mode, where you can enter a new name for the category. The name must 
follow the same rules as when the category was created.  

- Hide: hides the button of the category. See above how to show the buttons back.  

- Delete: deletes the category. The contained images are not deleted. The images that do not belong to 
a category anymore are automatically moved to Untagged.  

If there is a large number of categories, the control will show a horizontal scrollbar. You can scroll 
through the categories by dragging the scroll bar or by using the mouse wheel.  

 
 
11.5. Images Bar 

After analyzing the samples and/or regions, the user will obtain for each engine output a corresponding 
image. The image results depend on the output type: 

 Gray (8 bit or 16 bit) 

 Coded 

 Color 

 Float 

 

 

Using images helps viewing a single output or a combination of outputs. 

About StrataQuest Images 

 An Image is defined by Backgrounds and Contours.  

 The Backgrounds can the Original image in case of BF samples) or Overlay in case of FL projects 
and any color, gray or float output. Gray images can be pseudo-colored by choosing a custom 
color. There are other options that will be detailed later. 
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 The Contours are coded images that represent different objects or masks. For every coded image 
there are various coloring options. 

 The images chosen to form a “SQ Image” can be from any layer. 

 The SQ Images can be organized in categories so it’s easier to manage them.  

 There are some predefined categories and users can define their own categories and assign SQ 
Images to them. 

 The predefined categories are “Favorites”, “Channels” – for FL projects, a category for each filter 
un FL-MS projects, History – for SQ Images created on the fly and “All Images” that groups all 
images when not viewing by categories. 

 The defined SQ Images will be the same for all samples in the same Sample Link. 

 The user can order images by drag and drop. 

 Double click on an image to rename it. 

 Drag an image to a category from the above toolbar in order to assign it that category. 

 Click on the star icon to make an image favorites or remove it from Favorites. 

 Click + to add a new image. 

 

11.6. Diagrams 

A StrataQuest feature of major importance is the ability to show, plot and visualize events measurements 
in form of diagrams.  

This allows visualising cellular subpopulations within a given sample and/or compare across ROIs and 
samples. Any of the measurement parameters delivered by StrataQuest may be displayed in a diagram. 
By setting cutoff values and/or gates positive and negative, cell populations can be determined. The values 
of the event parameters can be used to build diagrams. 

 

To show diagrams in the right side panel, go to StrataQuest main menu -> View -> Diagrams, and check 
Diagrams. 
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Diagram Operations 

Within Diagrams Panel, diagrams can be rearranged using drag-and-drop on the upper area of the 
diagram. 

   

 If Diagrams Panel changes dimensions, the diagrams will also automatically resize (within 
certain min and max size limits). 

 You can zoom in/out a diagram using the mouse wheel. 

 Fit a diagram using mouse right click, then drag from right to left. 

 Zoom just a part of a diagram by using the mouse right click and drag from left to right to define 
a rectangle. 

 Pan a diagram using click and drag. 

 Click the upper right button to show diagrams in full screen, enlarging selected diagram and 
showing its statistics. 

Note: The same operation can be done by double clicking on a diagram. 
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 Edit diagrams names, axes names, gates names, cutoff values by double clicking on them. 

 A diagram becomes active for user interaction when clicking on it. The selected diagram will 
have orange borders and will display a toolbar. 

 

Adding new diagrams (see description for each below in this chapter): 

 Add Diagram (+): opens Add Diagram panel, where you can create standard diagrams: 
scattergrams and histograms. This is the default operation when pressing "+", the next ones can 
be found in the dropdown list. 

 Add t-SNE Diagram 

 Add UMAP Diagram 

 Add SONG Diagram 

 Add 3D Diagram 

 Add Phenotype Diagram 

 Add Violin Diagram 
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More diagram options 

 

 Add Default Diagrams 

 Manage Diagrams: opens Manage Diagrams panel 

 Manage Gates: opens Manage Gates panel 

 Delete All Diagrams 

Diagram Contextual Menu 

Right click on a diagram to show its contextual menu: 

 

 Reset Name: if changed by the user, the name will be reset to the default one; 

 Export: exports the image of the diagram; 

 Export Options: customize the diagram image to be exported (size, background, name, axis 
name); 
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 Copy/Paste: copy/paste the selected diagram. 

- Copy: copies the diagram as image, that can be pasted within an image editing application (such as 
Paint). Diagram image is copied by applying the settings from Export Options.   

- Paste:  pastes the previously copied object (may be a gate or a cutoff). 

 Delete: deletes selected diagram. 

 View Backward Data: displays a menu containing all possible options for backward data. For 
details see Chapter Forward and Backward Connection. 

 

 View Backward Data for Current Quadrant: opens backward data for the selected quadrant. For 
details see Chapter Forward and Backward Connection. 

 Validate Data: displays a menu containing all possible options for validating data. For details see 
Chapter Validation. 

 Validate Current Quadrant: opens validation panel for the selected quadrant. For details see 
Chapter Validation. 

 Generate Layer for Events: generate layer for events in a chosen quadrant;  

 Add Statistics Reports Column: adds a new Statistic Report column for the diagram.  

Axis Contextual Menu 

Right click on a diagram axis or name to show its contextual menu: 
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 Set visible range for selected axis: two values have to be set - one is the minimum for current 
axis, the other one is the maximum for current axis. 

Note: If you want to set chosen range to all axis having the same name, press Set to All. 

 Log range on: changes the display mode for the range and for the events in the diagram in 
logarithmic or linear. 

 Reset name: if changed by the user, the name will be reset to the default one.  

 

11.6.1. Scattergrams 

About Scattergrams 

1. A scattergram is an x/y or 2Ddiagram showing two measurement parameters for all data units or a 
selection thereof on a linear or logarithmic scale. Within the scattergram, cutoffs can be set in order to 
define a threshold for each measurement parameter.  

2. A gate is a subset of events within a scattergram that is selected by drawing a shape on a diagram. 
Gates may have rectangular, elliptic or polygonal shape and may contain any number of events within 
the diagram. Gates can also overlap each other. 

3. A cutoff is a numerical parameter, used as a threshold value in a diagram, in order to determine 
positive and negative measure events. It is graphically represented by a line on the axis of a diagram.  

4. Quadrant statistics are scattergram related statistics that show the percent of count/area of objects 
in a quadrant relative to the entire object population displayed in the scattergram. Graphically, the 
quadrant is the section defined by one or two cutoffs.   

In a scattergram, there are two parameters displayed against each other. Each parameter may be 
associated with a cutoff value. Whenever these two cutoff values (one on the x-axis and the second on 
the y-axis) are different from zero, which is the normal case, they define four quadrants within a 
scattergram. These four quadrants are:  

• upper-left (UL) quadrant: represents cells that are positive for the y-axis parameter, but negative for 
the x-axis parameter;  

• upper-right (UR) quadrant: represents cells that are double-positive for the parameters on both axes;  

• lower-left (LL) quadrant: represents cells that are double-negative for the parameters on both axes;  

• lower-right (LR) quadrant: represents cells that are positive for the x-axis parameter, but negative for 
the y-axis parameter. 

Notes 

- The precondition for the calculation of the quadrant statistics consists in already defined cutoff values 
for the axes of the scattergram. 

- The rows of the quadrant contain information about the four quadrants and the sum (overall). 

- A separate statistic is provided for the scattergrams without gates, as well as for each gate that is 
defined. 
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Create Scattergrams 

To create a scattergram, press Add Diagram button. 

 

 

In the Diagram Properties, define the properties for the new scattergram: 

 Layer 

 X /Y Axis 

 Name 

 Input gates 

Press Add and Continue to create current scattergram and continue adding more scattergrams or Add 
and Close to create current scattergram and close Scattergram Properties. 

Scattergrams Options 

The scattergram toolbar placed on each scattergram above the diagram area. 
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 Percent: shows the available options for computing and displaying the percentage of each 
quadrant: 

- events count percentage of each quadrant  

- events area percentage if the area measurement is available 

 

 Hide: hides the diagram. To make hidden diagram visible again, go to Manage Diagrams and 
change the visibility status. 

 Delete: deletes the selected diagram; 

 Add Cutoff: add manual cutoff, add automatic cutoff, percentile or delete existing cutoffs; 

 

 Add Gate: add a rectangular, elliptical or polygonal gate.  There's also the option to delete all 
gates. 

 Use Heat Map (Color Map): the graphical representation specific to a color map shows up data 
where the individual values contained in a matrix are represented as colors. Heat Map is 
computed just for the events visible within the range set for axis. You will observe that when 
zooming in/out, the events will appear initially as dots, then as a recalculated Heat Map.  For 
visualizing the Heat Map for all events from a scattergram, first you should press Fit button, 
then activate Heat Map button.  

To use color map feature, press Heat Map button from the scattergram toolbar and the dots of the 
scattergram will be automatically converted into a color map image. You can also choose the graphical 
appearance of the map, as shown below: 
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  Fit events into view: optimizes events display in scattergram. 

 

Configure Scattergram 

Any existing scattergram can be configured if necessary. To access configuration panel, press Configure 
Diagram button: 

 

 

In Configure Diagram panel, you can modify all the parameters of the scattergram. 

The lower part displays information when selecting a diagram: 

 

 X and Y values depending on the mouse position. 
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 The range for the two axes, that can be magnified within a tooltip if hovering with the mouse 
over it. 

 

Scattergrams Contextual Menu 

In addition, by right clicking on a scattergram, a contextual menu like the one below will appear. For 
details see Chapter Diagrams. 

 

Create Scattergrams 

To create a scattergram, press Add Diagram button. 

   

In Add Diagram panel, define the properties for the new scattergram: 

 Layer: the layer for which the diagram will be defined 

 X and Y Axis: select the measurements you want to have for the axes, defined in the selected 
layer. You can also edit, apply and reset name for the axis. 

 Name 
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 Input Gates: shows all the available gates, quadrants and phenotypes defined in other diagrams 
within the selected layer. If you want to view in the diagram only the events from one or 
multiple gates, select it here. The gates can be listed as a simple list, or by the diagrams they 
belong to. This view type can be changed by checking/unchecking the Show gates by diagrams 
option. 

Note: Based on selected options, a preview of the diagram will be updated on the right side of the 
window.  

 

Add Default Diagram 

This feature adds diagrams for the default measurements (area and mean intensity) from each layer, if 
they are defined: an area/mean intensity scattergram and two histograms, one for the area and one for 
mean intensity per each layer. 

Add Default Diagram is enabled if no other diagrams exist. 

 

Manage Diagrams 

Choose Manage Diagrams from the Diagrams main toolbar - > More Options. 

   

 

 A list of all the diagrams will be shown for a better overview. Here you can add, delete, configure, 
reorder or delete all the diagrams.  

 In this panel you can add diagrams or delete all diagrams. 

 All existing diagrams are listed, and the selected one is displayed on the right side. 

 If clicking any item from the list, you can choose to configure it or delete it. 
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 You can rearrange diagrams using the drag-and-drop feature. The diagram order will be also 
reflected within Diagrams tab. 

 Click the upper right button to show diagrams in full screen, enlarging the selected diagram and 
showing its statistics. 

Note: The same operation can be done by double clicking on a diagram. 

     
   

11.6.2. Histograms 

Histograms are another form of diagrams that help to visualize measurement data obtained by analysis 
of tissue samples. A histogram is a bar of a frequency distribution in which the frequency of one 
measurement parameter is represented by the height of the bar, and the class interval by the width. 

In other words, a histogram tells us “how many cells express how much” of a given marker. As any 
graphical chart, it is based on classes, in StrataQuest these classes meaning sets of events (e.g. with similar 
color density). It may appear like bins, line style and line style with fill. 

 

Create Histograms 

To create a histogram, press Add Diagram button. 
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In the Diagram Properties, define the properties for the new histogram: 

 Layer 

 X Axis 

 Name 

 Input gates 

  

Press Add and Continue to create current histogram and continue adding more histograms or Add and 
Close to create current histogram and close Histogram Properties. 

The histogram toolbar ( ) is 
placed on each histogram above the diagram area. 

In addition, by pressing the right mouse button on a histogram, a contextual menu like the one below will 
appear: 

 

Histograms Options 

The histogram toolbar placed on each scattergram above the diagram area. 

 

 Percent: shows percent for the selected histogram; 
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 Hide: hides the selected histogram; 

 Delete: deletes the selected histogram; 

 Add Cutoff: adds the automatic cutoff, deletes the existing cutoffs; 

 
 Add Gate: adds rectangular gates (only rectangular gates are available for histograms).  There's 

also the option to delete all gates. 

  Fit events into view: optimizes events display in scattergram. 

 

Histogram Contextual Menu 

In addition, by right clicking on a histogram, a contextual menu like the one below will appear: 

 
 Reset Name: resets histogram's name to original; 

 Delete: deletes selected histogram; 

 View Backward Data displays a menu containing all possible options for backward data on a 
histogram; 

 View Backward Data for Current Quadrant will display the events inside the current quadrant; 

 Validate Data: choose the data you want to validate; 
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 Validate Current Quadrant: choose to validate data for the current quadrant; 

 Generate Layer for Events in: generate layer for events in a chosen quadrant; 

 

 Add Statistics Report Column for: add statistics report column for a chosen quadrant. 
 
 
 

11.6.3. 3D Diagrams 

3D diagrams allow visualizing the distribution of three measurements of interest along three axes (x, y, 
z) in one diagram. It can be easily added from a drop-down menu by clicking icon in Diagrams tab 
on the right panel.  

You can select the cell phenotypes or gates/quadrants, defined in prior analysis steps, which are usually 
selected by the mean intensity of a corresponding marker.  

This is especially useful for e.g. studying two cell phenotypes expressing a common protein for 
immediate comparison of the expression pattern in these cells.  

The examples of such 3D diagrams show the distribution of CD4+ (in green) and CD8+ T cells (in yellow) 
as well as CK+ epithelial cells (in blue) in a sample, another – distribution of PD1 (in blue) in CD4+ (in 
green) and CD8+ T cells (in yellow). 
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11.6.4. t-SNE, UMAP and SONG Diagrams 

StrataQuest provides manifold learning techniques (also called dimensionality reduction) to allow 
transformation of high-dimensional data onto a lower-dimensional space.  

This includes t-distributed stochastic neighbour embedding (t-SNE) and Uniform Manifold 
Approximation and Projection (UMAP), both are non-linear methods and can therefore exploit more 
complex relationships between features when building the lower-dimensional representation. These 
techniques can be used to explore the dataset and uncover similarities between cell phenotypes based 
on certain parameters. 

A manifold learning plot represents cell phenotypes distributed across two axes of dimension 1 and 2, 
where two dots close to each other imply more similarity between two corresponding cells, e.g. 
similarity in staining intensity, area, etc. 

Certain cell populations are colored by the gating strategy used in standard scattergrams for defining a 
cell phenotype (e.g. CK+ cells are shown in blue). 
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Self-Organizing Nebulous Growths (SONG) 

StrataQuest supports Self-Organizing Nebulous Growths (SONG). SONG is a nonparametric 
dimensionality reduction technique, including t-distributed Stochastic Neighbor Embedding (t-SNE) and 
uniform manifold approximation and projection (UMAP).   Find out more on [PDF] Self-Organizing 
Nebulous Growths for Robust and Incremental Data Visualization | Semantic Scholar. 

 

11.6.5. Phenotypes 

This section concerns the interpretation of analysis results using phenotype diagrams and phenotype 
interactions engine. 

Phenotype diagrams are related to phenotypes definition and specific cells identifications. 

Phenotype interactions, on the other hand, are meant to identify connections between two cells of 
different phenotypes. An interaction is defined as two cells of user defined phenotypes being closer 
than a user defined distance. The interactions are visually represented by lines connecting the cells 
interacting. 

Note: For a detailed description of the Phenotype Interaction engine , see Chapter Phenotype 
Interactions from the StrataQuest V8 Engines References document. 

Having the phenotypes of interest defined and a maximum distance in μm in which it is considered that 
cells of different phenotypes are interacting, the algorithm generates a visual representation of the 
interactions found (lines connecting the interacting cells) and allows to represent the numerical data in 
scattergrams. 

An example of such a scattergram shows the number of interactions for each CD4+ T cell with the CK+ 
epithelial cells around it, where an interaction is considered to take place between a CD4 T cell and a 
CK+ epithelial cell, if they are within a 30 um range from each other. By gating the population of CD4+ T 
cells interacting with CK+ epithelial cells, it is possible to classify de CD4+ T cells based on the number of 
interactions: low activity / small number of interactions (1-4), medium activity / average number of 
interactions (4-8), high activity / high number of interactions (9+). 
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11.6.6. Violin Diagrams 

The Violin plot is useful for comparing the expression pattern of a marker of interest in several cellular 
phenotypes simultaneously.  

Similar to a histogram, it can illustrate the distribution of cells according to the level of marker 
expression as well as show how homogenous or heterogenous a population is.  It can be added from 
drop-down menu on the Diagram tab.  

An example of a violin plot was used to compare the expression pattern of PD1, a cellular marker 
important in cancer response, among all cells (gray), CK+ (epithelial cells), CD4+ T helper cells (green) 
and CD8+ cytotoxic T cells (yellow).  

  

11.6.7. Manage Diagrams 

Go to Diagrams section and, from the More menu, choose Manage Diagrams option. 

It will display a dialog where it is possible to create, configure, delete and reorder diagrams. 

Click on a diagram from the list to display its details on the right side of the panel. 
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Press Add diagram (+) button to add scattergrams or histograms. For details, see 
Chapters Scattergrams and Histograms. 

 

Press the arrow button to access the dropdown menu that allows adding other diagram types (see 
details for these diagram types in Diagrams):  
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Press the More button to access other options: 

 

 Add Default Diagrams 

 Delete All Diagrams 

Note: Add Default Diagrams option is enabled only when there are no diagrams present in the project. 

 

Operations in the diagram list 

 Diagrams from the Manage Diagrams list can be rearranged by using drag-and-drop feature. 

 

 When right clicking on a diagram row, a menu will appear. It has two options: Configure (will 
open Configure Diagram window, where you can modify the setting for current diagram) and 
Delete.  
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Note: For Phenotypes there are more options in the menu: Bring to front, Apply color, etc. For details 
see Chapter Phenotype Diagrams. 

 You can show/hide a diagram in the list by using the checkbox from the Visibility column in 
Manage Diagrams window. 

 

11.6.8. Cutoffs 

Add cutoff 

You can add a cutoff by opening the dropdown menu of the Cutoff button and choosing Manual or 
Automatic. 

 

 Manual 

- Click Cutoff button in the scattergram toolbar;  

- Move the mouse to the position where to set the cutoff. During this operation, the mouse is captured 
inside the diagram area;  

- Finally, the cutoff is determined by pressing the left mouse button on the desired position in the 
diagram. 

 Automatic 
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From the dropdown, select the type of cutoff, it will be automatically created on all existing diagram. 

 Delete all 

Deletes all cutoffs. 

 

Modify cutoff 

- Move the mouse cursor over the cutoff (the cursor will change its shape) and drag it to modify the 
value of the cutoff. It is not possible to move both (horizontal and vertical) cutoffs, only the vertical 
cutoff or only the horizontal cutoff; 

- Click on the cutoff using the left mouse button;  

- Move the cutoff to the desired new position;  

- Finish the cutoff reset operation by pressing again the left mouse button; 

- The value of a cutoff can be changed in-place. Double click on the value and, in the edit box that 
appears, write the new value. Press Enter to apply new value. To give up entering the new value, press 
Esc. 

Cutoff contextual menu 

 

- Set as Local Cutoff: cutoff is locally set on a region (you can recognize a local cutoff as its value is 
written in italic); 

 

- Set as Global Cutoff: cutoff propagates to all diagrams from the sample links; 
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- Copy: copies the selected cutoff; 

- Delete: deletes the selected cutoff. 

11.6.9. Gates 

In StrataQuest, a gate means selecting a set of events that represent a certain area of interest within a 
diagram. 

To access the Gates feature, press the Gates button from a diagram's toolbar. There are three types of 
gates: rectangle, ellipse and polygon.  

 

 

1. Add rectangular gate 

- Applies to the following diagram types: Histogram, Scattergram, t-SNE, UMAP, SONG, Phenotype.  

- Choose Rectangular in the Gates menu; 

- The starting point of the region of interest is defined by a click and drag from left to right inside the axis 
area. The left mouse button must be pressed to resize the rectangular region in order to obtain the desired 
size; 

- The left mouse button must be released to finally determine the gate. All events inside the gate change 
their color to a predefined hue. Additionally, the gate becomes labelled with a default text (e.g. „Gate 2“). 
The color, the label of each gate can be modified later; 
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2. Add elliptic gate 

- Applies to the following diagram types: Scattergram, t-SNE, UMAP, SONG, Phenotype; 

- Choose Ellipse in the Gates menu;  

- The starting point of the region of interest is defined by pressing the left mouse button inside the diagram 
area. The left mouse button must be pressed to resize the elliptical region in order to obtain the desired 
size; 

- The left mouse button must be released to finally determine the gate. All events inside the gate change 
their color to a predefined hue. Additionally, the gate becomes labelled with a default text (e.g. „Gate 2“). 
The color, the label of each gate can be modified later. 

 
 
3. Add custom/polygonal gate 

- Applies to the following diagram types: Scattergram, t-SNE, UMAP, SONG, Phenotype; 

- Choose Polygonal in the Gates menu;  

- The starting point (first corner) of the region of interest is defined by pressing the left mouse button 
inside the diagram area; 

- Thus, the first point of the polygon is defined and a line to the current mouse position appears. This line 
connects the starting point with the mouse cursor; 

- To define the next corner of the polygon, the left mouse button must be pressed somewhere in the 
diagram area; 

- Repeat the previous step until all desired points are defined; 

- The final step of setting a gate is to close the polygon. This means that the previously defined point is 
connected with the first point of the polygon. To perform that action, the right button of the mouse will 
be pressed inside the diagram area. All events inside the gate change their color to a predefined hue. 
Additionally, the gate becomes labelled with a default text (e.g. „Gate 2“). The color, the label of each 
gate can be modified later. 
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Modify gate 

 To move a gate, follow the steps below: 

-Begin the movement of the gate by pressing the left mouse button inside the shape; 

-Hold the left mouse button down while dragging the shape inside the diagram area; 

-Release the left mouse button to finally determine the gate’s new position. 

 To move the name of a gate, use click-and-drag feature. 

 The name of a gate can be edited in-place. Double click on the name and, in the edit box that 
appears, write the new name. Press Enter to apply new name. To give up entering the new name, 
press Esc. 

 To resize a gate, a set of resizing points are defined. For a rectangle, these points are the corners, 
for an ellipse there are eight resize points and, for the polygon, these points are the actual points 
of the shape. To resize a gate, follow the steps below: 

-Begin the resizing of the region by pressing the left mouse button on a resize point; 

-Hold the left mouse button down while dragging that point inside the diagram area; 

-Release the left mouse button to finally determine the gate’s new size. 

  

Gate Contextual Menu 

To access the Gate Contextual Menu, press the right mouse button on the contour of the gate.  
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 Configure: opens the Configure Gate dialog (see details below); 

 Copy: copies the selected gate; 

 Bring to front: brings the selected gate and its events (if colored) in front of other gates; 

Note: Overlapping gates can be successively selected by repeating a click on the intersection surface.  

 Apply color to belonging events: decide if the color of the gate will also apply to its events; 

Note: This operation also sets the coloring order for the events that belong to more gates at the same 
time.   

 Delete: deletes the selected gate; 

 View backward data for gate: shows backward data  for selected gate (see Chapter Forward and 
Backward Connection); 

 View Backward data around this point: shows backward data  around selected point in the gate 
(see Chapter Forward and Backward Connection);  

 Validate gate: opens validation panel for selected gate (see chapter Validation); 

 Validate around this point: opens validation panel for selected point in the gate (see chapter 
Validation);  

 Generate layer for Events in: creates a new layer where it adds an Import Coded engine 
containing the objects from the diagram, checks the chosen gate from the diagram and sets as 
detection Existing coded.   

 Add Statistics Report Column for: will include a column for selected gate in Statistics Report 
(see Chapter Statistic Report). 

 

Configure Gate 

For any gate, there is a set of management operations that can be performed, like changing the color, 
renaming the gate and choosing whether the label will be visible or not.  

To configure a gate, press the right mouse button inside the shape and choose the Configure… option 
from the menu. The gate configuration dialog will appear.  
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 Name: choose the name for the gate. 

Notes 

If you want to rename a gate and that name already exists, you will receive a warning message. 

  

- Color: here you can choose the color of the events within the gate; 

- Show Gate Name: by checking or unchecking this checkbox the name of the gate will be displayed or 
respectively hidden; 

- Reset Gate Name Position: resets gate name to its initial position after its name was replaced on the 
diagram area; 

- Draw Line Indicator from Name to Gate: draws a line between the gate name and the gate if they are 
distanced, so you can easily know what is the name of each gate;  

- Position: it is possible to modify gate's coordinates (left, right, top, bottom); 

- Selected Gate Transparency: to easily locate the currently active gate, you can set a background 
transparency value for the gate.   

Note: Position field is available only for rectangular gates. 

  

 Delete gate 

To delete an existing gate from a diagram: 

- Press the right mouse button on the gate surface; 

- Choose the Delete option from the menu that appears. 

Note: If there are other diagrams using the gate to be deleted as input, you will be notified by a message, 
in order to decide if those diagrams should be deleted as well.  
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 View backward data for gate: shows backward data for selected gate; 

 View backward data around this point: shows backward data for a selected point;  

 Validate gate: opens the Validation Field for the selected gate in order to validate its events; 

 Validate around this point: opens the Validation Field for a certain point in order to validate its 
events;  

 Generate layer for events in: generates a layer for the events in a selected gate;  

 Add statistics report column: adds a statistics report column for a selected gate.  

 

Manage Gates 

Go to Diagrams section and, from the More menu, choose Manage Gates option. 

It will display a dialog where it is possible to configure, delete and reorder diagrams. 

Click on a gate from the list to display its gates on the right side of the panel. 

 

When right clicking on a gate, a menu will appear. 

 

Configure: will open Configure Gate window, where you can modify the settings for current gate.  

Bring to front: an event can belong to multiple gates; if more gates are present in a diagram, this option 
brings to front selected gate. 

Apply Color to Belonging Events: applies gate color to the events that belong to that gate. This option 
can be enabled/disabled directly in the list, by using the check located in the right side of each gate.  
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Delete: deletes the selected gate. 

 

11.7. Backward and Forward Connection 

Two useful tools in StrataQuest are Backward and Forward Connection. They realize the identification of 
events between diagrams, raw data and the corresponding images from each marker of events. 

This function establishes a connection between a single event - or a group of events (e.g. in a gate or a 
quadrant) and their original location in the source images and visualizes where certain cells or cell 
populations are located in the tissue sample.  

1. Backward Connection  

This feature can be accessed from a quadrant or gate from scattergrams/histograms and from raw data 
for filtered events. 

To open Backward Connection: 

- right click inside a diagram, then choose View backward data;  

- right click inside a gate, in this case choose View backward data for Gate ...; 

- when you want to visualize the data for a certain quadrant generated by a cutoff, just choose the 
quadrant from the menu, as shown in the image below; 

   

After pressing View Backward Data for a certain source (quadrant, gate), these events will be shown 
with red contours. The other events will have green contours. 

In the example from below image, the events from the right quadrant have red contours and the rest of 
the events (from the left quadrant) are shown in green. 
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Once the backward connection is active, a new control (BC) will appear in the Image Viewer toolbar: 

 

You can navigate between the events by using the arrows: First, Last, Next, Previous. 

To close backward connection, press the BC green button. 

 

Backward Data from Scattergrams 

Accessing the contextual menu of the scattergrams, a set of operations for backward data will be 
displayed when choosing View Backward Data…: 
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 View Backward Data Around this Point - shows the backward data of the events on a small area 

around the mouse cursor; 

 View Backward Data for Left / Right Quadrants - shows the backward data of the events placed 
on any of the two quadrants created by the vertical axis of the cutoff; 

 View Backward Data for Upper / Lower Quadrants - shows the backward data of the events 
placed on any of the two quadrants created by the horizontal axis of the cutoff; 

 View Backward Data for UL / UR / LL / LR Quadrant - shows the backward data of the events 
placed on any of the four quadrants created by the intersection of the cutoff axes. 

Choosing View Backward Data for Current Quadrant from the contextual menu of a scattergram, the 
events inside the current quadrant will be shown. 

Backward Data can be accessed from the contextual menu of gates: 

 

View Backward Data for Gate: shows the backward data for the events inside a gate. 

This option will open the raw data window for all events within a gate and highlight those events on the 
images in a special color or with a labelled binary mask overlay (depending on the user’s selection). 

Backward data from Histograms 
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By accessing the contextual menu of the histograms, a set of operations for backward data will be 
displayed when choosing View Backward Data…: 

 
 View Backward Data for Bin - shows the backward data for the events belonging to a bin; 

 View Backward Data for Left / Right Quadrants - shows the backward data of the events placed 
on any of the two quadrants created by the vertical axis of the cutoff. 

Choosing View Backward Data for Current Quadrant from the contextual menu of a histogram, the events 
inside the current quadrant will be shown. 

Notes: 

- Backward data cannot be accessed from the overlay diagrams of compare sets. 

- The source diagram for Backward Connection will have its layer name in red bold letters. The other 
diagrams from the respective layer will have their name in red, but without bold. If more layers are 
present, their diagrams will have regular white text.  

- In case there are no images with detected objects in the current sample, when enabling Backward 
Connection, StrataQuest will automatically add an image with detected objects on Original/Color 
Overlay. 

- In case there are more images with detected objects in the current sample (but none of them on display 
in the Image Viewer), when enabling Backward Connection, StrataQuest will display the first images 
available with detected objects. 

View only events from input gates 

When asking for backward connection from a diagram with input gates, only input gates events should be 
displayed by default on the images. This option is available in StrataQuest main menu → Settings → 
More → General → Backward Connection. To enable the option, mark the corresponding checkbox. 

 
 Backward Connection from Raw Data 
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Backward Connection can be made from Raw Data for filtered events. For details see Chapter Raw Data. 

 

2. Forward Connection 

By double-clicking on an event from the images, the event will be highlighted in the diagrams and also in 
the Raw Data window.  

The event marked with the square (blinking) indicator is also blinking in the scattergram, so that you can 
determine the position of each event in the scattergram. 

 

By double-clicking on a row in the Raw Data grid, that event will be highlighted in the Image Viewer and 
diagrams.  

 

To stop the highlighting click anywhere on the Region Viewer. 
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11.8. Validation 

Validation means visualizing a set of events one by one, in order to manually assign each event one or 
more values. 

The StrataQuest diagrams include the Validation option in the contextual menu of each diagram. There 
are various validation options: validating events from a gate, from a quadrant/group of quadrants, 
validate elements around a point. 

  

  

Validation Mode 

In Validation Mode, you can validate each crop and also export related data.  

By choosing a validation option, Validation dialog will open. 

  

In the image viewer you can visualize highlighted the events included in validation. The type of images 
that you select in the viewer will be inherited for validation. 
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Navigate through image crops by scrolling or using the arrows and check an option to validate/invalidate 
each crop. 

 

 Options 

If right clicking on a validation image you will open a popup window with a magnified view. You can also 
zoom here with the mouse wheel. 
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Select Events 

It is possible to select all the events to be included in validation. Also, you can clear the current selection. 

Selecting attributes can also be done by checking individual events. The user can set the same value for 
an attribute for all selected events. 

      

Manage Validation Fields 

In this dialog you can add new validations fields and manage them. 
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 Add Field - adds a new field in the list. The name is configurable. 

 Add Value - adds a new value in the values field. This value is configurable: you can add a 
description, a color or you can remove it. 

  Mark the Use checkbox to include existing fields in validation. 

  

 Generate Report 

StrataQuest gives the possibility to generate a validation report. 

Press Report button to open Crops Report Configuration. 

 

Now select the information you want to include in the report: 

 The validation field type 

 The type of filter 

 The layer measurements 

When you are done, press Generate Report button. You report will be issued and you will be able to save 
it by choosing from more types of file formats. 

 

Crop Size 
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Crop Size defines the size of the images extracted for an event. 

Define the crop size by giving it a specified value and by choosing to what layer it will apply. Also, you can 
choose a crop size as default for further use. 

 

  

12. Reports 
 
12.1. Statistic Report 

The Statistics Report is a StrataQuest tool that allows the user to compute different statistics for a 
selected population or subpopulation of objects across multiple selected regions of interest, starting from 
more predefined values.  

 Global Measurements:  Area, Perimeter, Events Count, Density. These measurements apply to 
the entire population of events. 

 Extract a statistic value for a (sub) population: the value can be Percent, Count, Min, Max, etc 
and the subset can be selected from a diagram, a gate or a phenotype.  

 Combining already defined statistic values: using arithmetic operators. 

  

It can be found in the main menu: Tools → StaƟsƟcs Report. 

 

Statistics Report window will open. 
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 You can create a new statistic by pressing "+".  

 New Statistics panel will open; here you can choose what type of statistics you want to create: 

- Global Measurements 

- From Histogram 

- From Scattergram 

- From Gate 

- Computed Parameters 

- Computed with Scalar 

 
1. Global Measurement 
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The Global Measurement Parameters section will display two items: 

 Column Name: the new statistics is provided with a default name, but you can change the 
suggested naming; 

 Global Measurement: select one of the available global measurement values; this section allows 
the user to choose one of the following statistics: Area (mm²), Perimeter (mm), Events Count, 
Density, Layer (the statistics will be computed for objects produced by a specific layer). 

 

2. From Histogram 

This section allows using the report a statistics value extracted from a histogram. 

 

In order to use in the report a statistics value extracted from a histogram existing in the project, select the 
input data. 
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-Choose a name for the column; 

-Select layer; 

-Select a parameter to be computed in the statistics. 

 
 
Note: After choosing a unit, in certain cases you also have to select a measurement.  

 

 -Select a histogram from where to extract the statistics values to be used in the report; 

 

-Select the type of events to be used in the report. 



 

168 

  
3. From Scattergram 

This section allows using in the report a statistics value extracted from a scattergram existing in the 
project. 

 

In order to use in the report a statistics value extracted from a scattergram existing in the project, select 
the input data. 

-Choose a name for the column; 

-Select layer; 

-Select a parameter to be computed in the statistics; 

 

 Note: After choosing a unit, in certain cases you also have to select a measurement.  
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-Select a quadrant of the scattergrams; the events from this quadrant will be used in the statistics report; 

 
4. From Gate 
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In order to use in the report a statistics value extracted from a gate existing in the project: 

 Give a name to the column; 

 Select the gate you want to use; 

 Select predefined value and measurement.  

 Note: After choosing a unit, in certain cases you also have to select a measurement.   

 

5. Computed Parameters 

 

You can define a new column using a formula consisting of simple binary arithmetic operators.  

  Give a name to the column; 

  Choose the operands for the formula. You can use in the formula previously defined statistics;  

  Choose the operator for the formula. 

 
6. Computed with Scalar 
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You can define a new column using a formula consisting of simple binary arithmetic operators, one of 
them being a scalar value.  

  Give a name to the column; 

  Choose the operands for the formula. You can use in the formula previously defined statistics 
and a scalar value at your choice; 

  Choose the operator for the formula. 

 

If checking Scalar first, the scalar value will be the first operand of the formula. 

After adding statistics, they are displayed in the statistics list. 

 

Manage Statistics:  

 From Manage Statistics button, you can edit/delete selected statistic or delete all statistics. 
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After defining statistics, you can generate statistics results.  

1. Select samples/regions for which statistics will be computed; 

2. Press Generate Statistics button; 

3. Check the results in Statistics list. 

 

To clear statistics results, press the arrow button and choose Clear Generated Statistics. 

 

Export Statistics 

After generating statistics, you can export the results in Excel (.xlsx) by pressing Export Statistics to Excel 
button. 

 

 

Statistics for projects with more Sample Links 

The statistics are saved in a project for each individual link. 

In a project with two or more layers, you must define statistics separately for each layer. 
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Note: If for a link there are no statistics defined, but you select some of its regions, you will be notified. 

To continue, it is necessary to define statistics for the respective sample link. 

 

In the image below, you can see an example of statistics generated for two sample links. 

 

12.2. Report Generator 

To generate a report out of your project, go to: 

 Tools → Report Generator from the main window menu of StrataQuest; 
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Manually select the regions to be included in the print report or use any of the options displayed in the 
Options menu: 

  

The following operations are available: 

 

 Include Scattergrams; 

 Include Scattergram Statistics; 

 Include Histograms; 

 Include Histogram Statistics; 

 Include Processed Images; 
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 Include Observations: by pressing the Edit Observations button, the observation page can be 
edited. 

 Include Notes page: Notes page will be included in the report. The Notes page is a white page 
on which the user can add handwritten notes, signatures, stamps, second opinions, etc.  

 Include Only Visible Diagrams 

Press Generate Report to get your report and access print and export options: 

 

  

13. Project Profiles and APPs 

StrataQuest offers the possibility to reuse frequently utilized settings by defining a project profile. 
Creating a project and applying a project profile simplifies the usage of the application.  

A project profile contains analysis settings (layers and engines), visualization buttons (image types), 
diagrams and statistics. 

Project profiles offer support for the analysis of samples with different settings in the same StrataQuest 
project.   

A Project Profile contains a set of sample profiles that can be used in a new project. 

How to save a Project Profile 

The Save Project Profile option can be accessed by choosing SQ Main Menu → Project →Save Project 
Profile. 
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The following window will open:  

 

You can create a profile from a current project. 

These are the steps: 

- Select desired sample that will be used to extract settings for the profile; 

- Give a name to the profile; 

- Press Add Sample Profile button to create the new profile, which will be listed in the Current Sample 
Profiles section; 

- Check Automatically Enter in Easy Mode if you like (StrataQuest will automatically display Easy Mode if 
this is checked); 

 

Note: Please ensure that you have easy mode defined for the selected sample, otherwise you will not 
have the possibility to change any setting. 

- To erase a selected profile from the Current Sample Profiles section, press Remove Item button; 

- To erase all the profiles from the Current Sample Profiles section, press Remove All button; 

- Give a name for the new profile file; 

- Press Save button. 



 

177 

  

Load Project Profile 

To load a project profile, go to SQ Main Menu → Project → Load Project Profile: 

 

The Load Profile window will open: 

 

Here, you can define what sample profile will be applied to each sample, as in the picture below. 

 

 

Save App 

An APP is similar to a Project Profile but it contains an Easy Mode view. 
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Note: You need a license to be able to save your own APPs. 

After creating a StrataQuest App, you can save it for further use by going to SQ Main Menu → Project → 
Save App. 

 

In the Save App dialog, you have to configure the app to be saved: 

 Select the source sample; 

 Choose a name for the app; 

 Select an app group; 

 The file will be automatically named, but you can choose to change that name; 

 Press Save to save the app. 

 

Note: Save App feature may or may not be available depending on the type of license you own. 

Load App  

Load App feature allows managing existing apps and loading apps to current project. 

On the left side of the dialog, select an app by clicking on the thumb image. 
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There are more app categories: Fluorescence, Brightfield, Favorites and Uncategorized. 

App's More menu includes the following options: 

 

 Manage App Groups 

 

The following operations are available: 
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- Add app 

- Rename app 

- Delete app 

- Move up 

- Move down 

- Hide app 

 Install Apps 

Use this option to browse on your computer for a new app you want to install. 

 

Selecting samples 

On the right side, check the project items where you wish to load the selected app. 

 

You can choose to: 

 Select All: Select all listed project items; 

 Unselect All: Unselect all listed project items; 

 Invert Selection: inverts selection for the listed project items. 
 

13.1. Channels Mapping 

The Channels Mapping feature was created for the situations when your profile or APP has a set of names 
for channels but your project has other names for the channels. Therefore, a mapping between the 
channels of the profile and the channels of the project has to be made in order to apply the profile to your 
project. 

Note: Channels mapping feature is only available for fluorescence. 

Channels Mapping button can be found in the Load Profile, Load APP and Sample Linking. 
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Note: Channels Mapping feature is also available when creating a new project. When you want to apply 
a certain profile to your project, StrataQuest will inform you if the sample profile does not have the 
same configuration of channels as the current sample. You can choose to manually make the 
correspondence between the channels.  

After pressing Channels Mapping button, a dialog will open. 

 In the Channels Mapping dialog, you can perform the actual channels mapping by setting 
corresponding names to the channels of the sample and project. 

  

Set selection to all samples button will apply setting made for a sample to all samples having the same 
channels. 
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Remove Sample from Link will remove the selected sample from the existing link. 

After finishing the mapping, press Apply to save the changes, then Close. 

14. Tools 

StrataQuest has a set of advanced tools that allow complex operations. 

To access these operations, go to StrataQuest main menu and select Tools. 

 

The following operations are available: 

 Statistics Report (see Chapter Statistic Report) 

 Sample Registration 

 Batch Operations 

 Report Generator (see Chapter Report Generator) 

 Transform Shapes 
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14.1. Sample Registration 

Sample registration feature concerns consecutive sections from a tissue, that are not 100% identical. 

The tissue cannot be applied on the slide in exactly the same position, orientation or angle, as it suffers 
mechanical deformations. 

Therefore, sample registration corrects as much as possible these differences between samples, 
however, a 100% match between samples is not possible. 

Notes: 

- This feature is optional and licensed individually. 

- Supported sample types are BF, FL and FL-MS. 

- Only samples of the same type can be chosen.  

- For FL samples, the channel to be used has to be selected. Also note that because samples cannot be 
linked (having different channels), you must adjust the 16bit range. 

 

 On the left there is the list of available samples. 

 The bold sample is the one set as reference. The RS buttons set the selected sample as 
reference. 

 The checked samples are the ones to register against the reference. 
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Workflow 

The workflow for sample registration is synthetized below: 

 

 

1. If Compute Registration was successful, the Apply Registration will become enabled. 

2. Pressing Apply Registration will make the dialog close and a new task gets enqueued in Task 
Manager. 

 

3. If the task is successfully completed, this will generate a new sample in the Project Browser. The 
name is automatically generated but the user can change it afterwards 
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4. The result is a new multichannel sample: BF-MC (if the source was BF) or FL. 

   

  

 

 

15.2. Batch Operations 

Batch operations is a feature that allows batch export as BigTiff for the existing regions. 

It can be accessed from StrataQuest main menu -> Tools -> Batch Operations. 
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 Select regions to be exported by marking the corresponding checkboxes in the left side of the 
panel. 

 

You can manage the region list by using the option from the More menu: 

 

- Select All 

- Clear Selection 

- Invert Selection 

- Show Search 

 

 Export Parameters 
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- Choose one of the available categories to export only the belonging images. To export all images, 
choose All Images option. 

- Browse for a location on your computer, where the exported images will be stored. 

- Resize images, if necessary. 

- Choose a compression type, if you want. 

 

- Adjust JPEG quality for the output files. 

14.3. Transform Shapes 

Any ROI, annotation or exclusion area can be converted into another type of shape. 

In the Transform Shapes panel, select desired item(s) by marking corresponding checkbox(es) (you can 
also perform multiple selection by using Ctrl control from the keyboard) or press Select… button for 
selecting all ROIs, all exclusion areas or all annotations. 
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Now, select the output type of shape in the lower part of the panel, then press Transform selected 
shapes button in order to effectively accomplish the operation. 

Note: Being a measurement tool, a line annotation cannot be transformed into other shapes. 
  

15. StrataQuest Main Menu 

  

StrataQuest Main Menu is a set of core operations of the application. 

 

1. Open (see Open Existing Project) 

2. Import (see Import Virtual Slides) 

3. Project: main project settings and features can be found here. 

 

- Load/ Save App: loads an existing App or saves the changes to the current App (see Apps chapter). 

- Load/ Save Project Profile: loads an existing Project Profile or saves the changes to the current Project 
Profile (see Project Profiles chapter). 

- Analyze: choose the project items you want to analyze and start the analysis. 
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- Properties: see main properties/components of the project in Project Properties panel. 

  

- Save 

- Save as 

- Raw data: access Raw data panel (see Raw Data chapter). 

- Diagrams: access Diagrams panel (see Diagrams chapter). 

- Gates: access Gates panel (see Gates chapter). 

- Finalize Analysis: StrataQuest will analyze all the items that were not analysed before. 

- Delete: cache, image results or all results of the analysis. 

- More: access shading correction (see Shading Correction chapter) and build cache. 

- Advanced Tools: access multiplexing and validation paths (see corresponding chapters). 
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4. Tools: includes important adjacent tools, each described further in a separate chapter. 

 

5. View: includes main settings regarding the visualization in StrataQuest, each described further in a 
separate chapter.  

 

 

6. Settings: includes SQ generic settings. 

  

- Language; 
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- Switch user; 

- More: will access StrataQuest core settings (see Chapter StrataQuest Generic Settings); 

- Install Apps: opens a browser where you can select a StrataQuest app and install it; 

- Install Profiles: opens a browser where you can select a StrataQuest profile and install it.  

 

7. Help: includes helping tools of StrataQuest, for an easier interaction with the application. 

 

- Quick Guide 

- User Manual 

- Engines References manual 

- Human Protein Atlas 

- About StrataQuest 
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15.1. StrataQuest Generic Settings 

 

StrataQuest Generic settings can be found in StrataQuest main menu -> Settings -> More. 

They contain three main sections: General, Diagrams, System Data. 

 

1. General Settings 

 Analysis 

 

In the Analysis section, you can change the color separation and segmentation methods, the options for 
the Analyze Project, or to choose whether to use the existing coded images for computing measurements. 

- Beep after finish, to announce you the analysis is done; 
- Shut down after finish: shouts down computer after the end of the acquisition; 
- Send e-Mail after acquisition finish: announces by email the acquisition is done; don’t forget to 
fill in the information about the SMTP server and the e-Mail address. 
 

 Backward Connection  

- Set the number of FOVs to be shown in backward connection.  
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 Task Manager 

 

- In the task manager, the number of concurrent running tasks will be set and also the number of 
threads assigned to a task. By using the parallel computing, the speed of analysis can be increased. 

Notes:  

- If the result of the multiplication between the maximum number of concurrent tasks and the number 
of threads for a task equals the number of cores in the PC (e.g. quad core CPU’s have 4 cores working in 
parallel), the overall performance of the computer for OTHER tasks and applications might become very 
poor. You may either leave the computer working on the StrataQuest analysis only or select a number of 
concurrent tasks at least one lower than the number of cores in your computer. 

- In case the result of the respective multiplication overpasses the number of cores of the PC, there will 
be a warning message. 

 Support 

 

In this section, fill some data in order to receive support from TissueGnostics when necessary. 

- Use Submit Command: access an external executable file that will send the files to a server; 

- Auto Save Report: save the log files on the hard drive, no matter if the report is sent or not; 
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- Test Connection: verify whether you introduced the valid data in order to send your message; 

- Generate Exception: simulates generating an error message in order to check once again the validity of 
the data introduced in the fields; 

- Open Reports Folder: if a report is not sent, it will be automatically stored in a local folder; press Open 
Reports Folder to open that folder; 

- Send Saved Reports: press this button to send all unsent reports, if any. After effectively sending saved 
reports, they will be automatically erased from the local folder where they were stored; 

- Clear Reports Folder: will erase all reports from the folder; 

- Error description: see a short description of the error; 

- Error detail: detailed data related to the error; 

- Product Improvement Program checkbox: In the Product Improvement Program participating systems 
send information to TissueGnostics about how they use certain products. Received data is combined to 
help TissueGnostics solve problems and to improve the products and their features. Click the link in the 
lower-left corner of the dialog shown above to read about this program and check I agree checkbox if 
you want to participate. If you don’t check the check-box the Send Error button will be disabled; 

- Hide Details : display or hide the data list related to the error; 

- Submit Report: send message to the support team; 

- Enable Verbose Logging: this option provides detailed data for diagnoses; 

- Register ‘.sqproj’ file extension: creates a link between StrataQuest and the existing ‘.sqproj’ projects, 
in order to automatically open the application and the corresponding project when double clicking on 
the ‘.sqproj’ file. 

ONLY data associated with StrataQuest will be transferred to the TissueGnostics support department. 

 Image Viewer 
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- Default Colors: set the colors for ROI, Annotations, Group of ROIs, Exclusion Areas, RGB Indicator and 
scale bar;  

- Default Locations: set the location for the RGB Indicator, the Scale Bar and the Item Name;  

- Exclusion Area Transparency: using a slider, set the desired transparency value for the Exclusion Areas;  

- Overlay: set the color and the thickness of the selected and non-selected events in backward 
connection. Also, you can set here the color and thickness of the dots mask contour and the color 
membrane contour. Checking Show non-selected events in backward connection mode will show the 
non-selected events on the marker images in backward connection mode;  

- Animate borders of ROIs and Annotations: animates the borders in order to make them visible on any 
background. Enabling this may decrease the overall performance, as it requires relevant computing 
resources.  

- Highlight double-clicked point from Sample: highlights on the detail window the point where a 
double-click was performed on the main image viewer in order to open the sample;  

- Show grid lines for Samples imported from Folder: all the FOVs on the image will be delimitated by 
grid lines.  

- Show grid lines for Samples imported from TissueFAXS: all the FOVs on the image will be delimitated 
by grid lines.  

- Show name only for selected ROI: the label of the ROI will be shown only when the respective ROI will 
be selected;  

- Show name for Exclusion Area: the label of the Exclusion Area will be shown only when this checkbox 
is marked;  

- Show name only for selected Annotation: on the sample will only be displayed the name for selected 
annotations; 

- Show area bubble for shapes while drawing: shows in a bubble the dimensions of the drawn area 
while you are drawing it; 

- Include user name in annotations contents: if marking this checkbox, the user name will be included in 
the annotation edit box; 

- Show annotations in browser: by checking this option annotations will be displayed in the Project 
Items Properties panel; 

- Show perimeter of shapes: by checking this option the perimeter of the regions of interest will be 
shown in the Project Items Properties panel; 

- Recompute correction image after FOV removal: by checking this option the correction image will be 
recomputed after removing one or several FOVs.  

 Measurement Units 
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- Region area: display tissue areas in square millimetres or square micrometres. The default value is 
square millimetres; 

- Event Parameters: certain event parameters have measurement units (i.e. micrometre or square 
micrometre). The user can choose to display parameter values using both micrometres and millimetres. 
The default value is micrometre.  

The parameter values will be displayed according to the selected measurement unit in:  

- diagrams  

- statistics  

- reports  

- raw data 

 Confirmations 

This section allows setting confirmation messages for some operations in StrataQuest. If checked, these 
messages will pop up if it is the case.  

 

 

2. Diagrams Settings 
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 Common 

This section allows realizing the settings for the layout and the display of all diagrams. The Show Grid 
option will display the grid on all diagrams. 

• Display:  

- Show Grid: by checking this option, a grid will be displayed on each diagram.  

- Cutoff Color: set the color of the cutoff.  

• Cutoff Decimals: set the number of decimals for a cutoff value.  

• Small Range Limit: set the threshold value for an axis.  

• Cutoff Percentile Value: the events population according to a percent given by the user.  

If the value of an axis has is higher than the Small Range Limit Value, the number of decimals will be the 
one from Cutoff Decimals. If the value of an axis has is lower than the Small Range Limit Value, the 
number of decimals will be 2. 

 Scattergrams 

 

The point style and the point size can be set and adjusted. For Heatmaps, the point style and the point 
radius are adjustable. 
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 Histograms 

 

You can set here the bins count, the style and the color for the histograms. 

- Bins count: adjusts the number of bins using the trackbar. 

- Style: three styles are available in order to graphically represent a histogram (Bin Style, Line Style and 
Line Style with Fill). 

- Color: here you can adjust the color the events in the histogram. 

 

3. System Data Settings 

 Institution data 

 

Define here the name of his institution, the department and the laboratory he belongs to. This data will 
be used in Print Reports. 

 Users 
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- Here you can manage the users of the application. New StrataQuest users can be added by pressing 
the Add user button. The information about the already existing users can be modified from the Modify 
user… button. Any user can be deleted by selecting it and pressing the Delete user button. The 
password can be changed by pressing the Change Password button. 

- Modify user and Delete user options are available only for the Administrator. The standard user is 
allowed only to change his password. 

 Markers 

 

When creating a new marker, it is also saved and stored in a markers repository, in the system data. 

All the existing markers are displayed in a list, and a short description is available for each of them. The 
following operations are available for the markers:  

- Add 

- Rename 

- Remove 

- Remove All 


